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1 Introduction

Airodis is an environmental data management software package, designed as a powerful tool
for retrieving, validating, auditing and presenting data collected from a variety of
environmental monitoring systems.

Airodis provides the user with the ability to automatically retrieve data from a wide variety of
instruments and data loggers, perform audited automatic and manual data validation and
generate a wide range of graphical and tabular reports. 

Airodis operates on Windows 10 operating systems and above and uses a Microsoft SQL Server
database. Supporting single or multi user installations Airodis provides the user with the most
stable, streamlined and easy to use package available.

Multiple users can interrogate data contained within the SQL database and data can be pushed
directly to websites for public or internal display.

The Airodis design encapsulates Ecotech's 35 years experience in the development of
software and experience that Ecotech has operating one of the world's largest networks of
ISO17025 accredited monitoring systems.
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2 End User License Agreement

Acoem Australasia

End User License Agreement

NOTICE TO USER: PLEASE READ THIS CONTRACT CAREFULLY. BY USING ALL OR ANY PORTION OF
THE SOFTWARE YOU ACCEPT ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT,
INCLUDING, IN PARTICULAR THE LIMITATIONS ON: USE CONTAINED IN SECTION 2;
TRANSFERABILITY IN SECTION 4; WARRANTY IN SECTION 6 AND 7; AND LIABILITY IN SECTION 8.
YOU AGREE THAT THIS AGREEMENT IS ENFORCEABLE LIKE ANY WRITTEN NEGOTIATED
AGREEMENT SIGNED BY YOU. IF YOU DO NOT AGREE, DO NOT USE THIS SOFTWARE. IF YOU
ACQUIRED THE SOFTWARE ON TANGIBLE MEDIA (e.g. CD) WITHOUT AN OPPORTUNITY TO

REVIEW THIS LICENSE AND YOU DO NOT ACCEPT THIS AGREEMENT, YOU MAY OBTAIN A REFUND
OF THE AMOUNT YOU ORIGINALLY PAID IF YOU: (A) DO NOT USE THE SOFTWARE AND (B)
RETURN IT, WITH PROOF OF PAYMENT, TO THE LOCATION FROM WHICH IT WAS OBTAINED
WITHIN THIRTY (30) DAYS OF THE PURCHASE DATE.

1. DEFINITIONS
When used in this Agreement, the following terms shall have the respective meanings
indicated, such meanings to be applicable to both the singular and plural forms of the
terms defined: 

"Acoem" means Acoem Australasia, with its main address located at 1492 Ferntree Gully
Road, Knoxfield, Victoria, 3180, Australia.

"Software" means (a) all of the contents of the files, disk(s), CD-ROM(s) or other media
with which this Agreement is provided, including but not limited to (i) Acoem or third
party computer information or software; (ii) related explanatory written materials or files

("Documentation"); and (iii) fonts; and (b) upgrades, modified versions, updates,
additions, and copies of the Software, if any, licensed to you by Acoem (collectively,
"Updates").

"Use" or "Using" means to access, install, download, copy or otherwise benefit from using
the
functionality of the Software in accordance with the Documentation.

"Licensee" means You or Your Company, unless otherwise indicated.

"Permitted Number" means one (1) unless otherwise indicated under a valid license (e.g.
volume
license) granted by Acoem.

"Computer" means an electronic device that accepts information in digital or similar form
and
manipulates it for a specific result based on a sequence of instructions.

2. SOFTWARE LICENSE
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As long as you comply with the terms of this End User License Agreement (the
"Agreement"), Acoem grants to you a non-exclusive license to Use the Software for the
purposes described in the Documentation. Some third party materials included in the
Software may be subject to other terms and conditions, which are typically found in a
"Read Me" file located near such materials.

2.1 General Use
You may install and Use a copy of the Software on your compatible computer, up to the

Permitted Number of computers.

2.2 Server Use
No network use of the Software is permitted, including but not limited to, using the
Software either directly or through commands, data or instructions from or to a computer
not part of your internal network, for internet or web hosting services or by any user not
licensed to use this copy of the Software through a valid license from Acoem; and

2.3 Backup Copy
You may make one backup copy of the Software, provided your backup copy is not
installed or used on any computer. You may not transfer the rights to a backup copy
unless you transfer all rights in the Software as provided under Section 4.

2.4 Home Use
You as the primary user of the computer on which the Software is installed, may also
install the Software on one of your home computers. However, the Software may not be
used on your home computer at the same time the Software on the primary computer is
being used.

3. INTELLECTUAL PROPERTY RIGHTS
The Software and any copies that you are authorized by Acoem to make are the

intellectual property of and are owned by Acoem and its suppliers. The structure,
organization and code of the Software are the valuable trade secrets and confidential
information of Acoem and its suppliers. The Software is protected by copyright, including
without limitation by Australian Copyright Law, international treaty provisions and
applicable laws in the country in which it is being used. You may not copy the Software,
except as set forth in Section 2 ("Software License"). Any copies that you are permitted to
make pursuant to this Agreement must contain the same copyright and other proprietary
notices that appear on or in the Software. Unless specifically and expressly permitted by
Acoem, you agree not to modify, adapt or translate the Software. You also agree not to

reverse engineer, decompile, disassemble or otherwise attempt to discover the source
code of the Software except to the extent you may be expressly permitted to decompile
under applicable law, it is essential to do so in order to achieve operability of the Software
with another software program, and you have first requested Acoem to provide the
information necessary to achieve such operability and Acoem has not made such
information available. Acoem has the right to impose reasonable conditions and to
request a reasonable fee before providing such information. Any information supplied by
Acoem or obtained by you, as permitted hereunder, may only be used by you for the
purpose described herein and may not be disclosed to any third party or used to create
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any software which is substantially similar to the expression of the Software. Requests for
information should be directed to the Acoem Customer Support Department. Trademarks
shall be used in accordance with accepted trademark practice, including identification of
trademarks owners' names. Trademarks can only be used to identify printed output
produced by the Software and such use of any trademark does not give you any rights of
ownership in that trademark. Except as expressly stated above, this Agreement does not
grant you any intellectual property rights in the Software and all rights not expressly
granted herein are reserved by Acoem.

4. TRANSFER
You may not, rent, lease, sublicense or authorize all or any portion of the Software to be
copied onto another user's computer except as may be expressly permitted herein.   You
may, however, transfer all your rights to Use the Software to another person or legal
entity provided that: (a) you also transfer each this Agreement, the Software and all other

software or hardware bundled or pre-installed with the Software, including all copies,
updates and prior versions, to such person or entity; (b) you retain no copies, including

backups and copies stored on a computer; and (c) the receiving party accepts the terms
and conditions of this Agreement and any other terms and conditions upon which you
legally purchased a license to the Software. Notwithstanding the foregoing, you may not
transfer education, pre-release, or not for resale copies of the Software.

5. MULTIPLE ENVIRONMENT SOFTWARE / MULTIPLE LANGUAGE SOFTWARE / DUAL MEDIA
SOFTWARE / MULTIPLE COPIES/ BUNDLES / UPDATES

If the Software supports multiple platforms or languages, if you receive the Software on
multiple media, if you otherwise receive multiple copies of the Software, or if you

received the Software bundled with other software, the total number of your computers
on which all versions of the Software are installed may not exceed the Permitted Number.
You may not, rent, lease, sublicense, lend or transfer any versions or copies of such
Software you do not Use. If the Software is an Update to a previous version of the

Software, you must possess a valid license to such previous version in order to Use the

Update. You may continue to Use the previous version of the Software on your computer
after you receive the Update to assist you in the transition to the Update, provided that:
the Update and the previous version are installed on the same computer; the previous
version or copies thereof are not transferred to another party or computer unless all
copies of the Update are also transferred to such party or computer; and you acknowledge
that any obligation Acoem may have to support the previous version of the Software may
be ended upon availability of the Update.

6. NO WARRANTY

The Software is being delivered to you “AS IS” and Acoem makes no warranty as to its use
or performance.  ACOEM AND ITS SUPPLIERS DO NOT AND CANNOT WARRANT THE
PERFORMANCE OR RESULTS YOU MAY OBTAIN BY USING THE SOFTWARE. EXCEPT FOR ANY
WARRANTY, CONDITION, REPRESENTATION OR TERM TO THE EXTENT TO WHICH THE SAME
CANNOT OR MAY NOT BE EXCLUDED OR LIMITED BY LAW APPLICABLE TO YOU IN YOUR
JURISDICTION, ACOEM AND ITS SUPPLIERS MAKE NO WARRANTIES CONDITIONS,
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REPRESENTATIONS, OR TERMS (EXPRESS OR IMPLIED WHETHER BY STATUTE, COMMON
LAW, CUSTOM, USAGE OR OTHERWISE) AS TO ANY MATTER INCLUDING WITHOUT
LIMITATION NONINFRINGEMENT OF THIRD PARTY RIGHTS MERCHANTABILITY,
INTEGRATION, SATISFACTORY QUALITY, OR FITNESS FOR ANY PARTICULAR PURPOSE.

7. PRE-RELEASE PRODUCT ADDITIONAL TERMS
If the product you have received with this license is pre-commercial release or beta
Software ("Pre-release Software"), then the following Section applies. To the extent that
any provision in this Section is in conflict with any other term or condition in this
Agreement, this Section shall supercede such other term(s) and condition(s) with respect
to the Pre-release Software, but only to the extent necessary to resolve the conflict. You
acknowledge that the Software is a pre-release version, does not represent final product
from Acoem, and may contain bugs, errors and other problems that could cause system or
other failures and data loss. Consequently, the Pre-release Software is provided to you
"AS-IS", and Acoem disclaims any warranty or liability obligations to you of any kind.
WHERE LEGALLY LIABILITY CANNOT BE EXCLUDED FOR THE PRE-RELEASE SOFTWARE, BUT IT
MAY BE LIMITED, ACOEM’S LIABILITY AND THAT OF ITS SUPPLIERS SHALL BE LIMITED TO THE
SUM OF FIFTY DOLLARS (AUD $50) IN TOTAL. You acknowledge that Acoem has not
promised or guaranteed to you that Pre-release Software will be announced or made
available to anyone in the future, that Acoem has no express or implied obligation to you
to announce or introduce the Pre-release Software and that Acoem may not introduce a
product similar to or compatible with the Pre-release Software. Accordingly, you
acknowledge that any research or development that you perform regarding the Pre-
release Software or any product associated with the Pre-release Software is done entirely
at your own risk. During the term of this Agreement, if requested by Acoem, you will
provide feedback to Acoem regarding testing and use of the Pre-release Software,
including error or bug reports. You agree that you may not and certify that you will not
sublicense, lease, loan, rent, or transfer the Pre-release Software. Upon receipt of a later
unreleased version of the Pre-release Software or release by Acoem of a publicly released
commercial version of the Software, whether as a stand-alone product or as part of a
larger product, you agree to return or destroy all earlier Pre-release Software received
from Acoem and to abide by the terms of the End User License Agreement for any such
later versions of the Pre-release Software. Notwithstanding anything in this Section to the
contrary, if you are located outside of Australia, you agree that you will return or destroy
all unreleased versions of the Pre-release Software within thirty (30) days of the
completion of your testing of the Software when such date is earlier than the date for
Acoem's first commercial shipment of the publicly released (commercial) Software.

8. LIMITATION OF LIABILITY
IN NO EVENT WILL ACOEM OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY DAMAGES, CLAIMS
OR COSTS WHATSOEVER OR ANY CONSEQUENTIAL, INDIRECT, INCIDENTAL DAMAGES, OR
ANY LOST PROFITS OR LOST SAVINGS, EVEN IF AN ACOEM REPRESENTATIVE HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH LOSS, DAMAGES, CLAIMS OR COSTS OR FOR ANY
CLAIM BY ANY THIRD PARTY. THE FOREGOING LIMITATIONS AND EXCLUSIONS APPLY TO THE
EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION. ACOEM'S AGGREGATE
LIABILITY AND THAT OF ITS SUPPLIERS UNDER OR IN CONNECTION WITH THIS AGREEMENT
SHALL BE LIMITED TO THE AMOUNT PAID FOR THE SOFTWARE, IF ANY. Nothing contained in



12 Airodis Manual

© Acoem and related entities 2023

this Agreement limits Acoem's liability to you in the event of death or personal injury
resulting from Acoem's negligence or for the tort of deceit (fraud). Acoem is acting on
behalf of its suppliers for the purpose of disclaiming, excluding and/or limiting
obligations, warranties and liability as provided in this Agreement, but in no other
respects and for no other purpose. For further information, please see the jurisdiction
specific information at the end of this Agreement, if any, or contact Acoem's Customer
Support Department.

9. EXPORT RULES
You agree that the Software will not be shipped, transferred or exported into any country
or used in any manner prohibited by Australian or United Nations export laws, restrictions
or regulations (collectively the "Export Laws"). In addition, if the Software is identified as
export controlled items under the Export Laws, you represent and warrant that you are not
a citizen, or otherwise located within, an embargoed nation and that you are not
otherwise prohibited under the Export Laws from receiving the Software. All rights to Use
the Software are granted on condition that such rights are forfeited if you fail to comply
with the terms of this Agreement.

10. GOVERNING LAW
This Agreement will be governed by and construed in accordance with the substantive
laws in force in the State of Victoria, Australia. The courts of Victoria, Australia have
exclusive jurisdiction over all disputes relating to this Agreement. This Agreement will not
be governed by the conflict of law rules of any jurisdiction or the United Nations
Convention on Contracts for the International Sale of Goods, the application of which is
expressly excluded.

11. GENERAL PROVISIONS
If any part of this Agreement is found void and unenforceable, it will not affect the validity
of the balance of the Agreement, which shall remain valid and enforceable according to its
terms. This Agreement shall not prejudice the statutory rights of any party dealing as a
consumer. This Agreement may only be modified by a writing signed by an authorized
officer of Acoem. Updates may be licensed to you by Acoem with additional or different
terms. This is the entire agreement between Acoem and you relating to the Software and
it supersedes any prior representations, discussions, undertakings, communications or
advertising relating to the Software.

12. NOTICE TO U.S. GOVERNMENT END USERS
The Software and Documentation are "Commercial Items," as that term is defined at 48
C.F.R. §2.101, consisting of "Commercial Computer Software" and "Commercial Computer
Software Documentation," as such terms are used in 48 C.F.R. §12.212 or 48 C.F.R.
§227.7202, as applicable. Consistent with 48 C.F.R. §12.212 or 48 C.F.R. §§227.7202-1
through 227.7202-4, as applicable, the Commercial Computer Software and Commercial
Computer Software Documentation are being licensed to U.S. Government end users (a)
only as Commercial Items and (b) with only those rights as are granted to all other end
users pursuant to the terms and conditions herein.

13. COMPLIANCE WITH LICENSES
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If you are a business or organization, you agree that upon request from Acoem or Acoem's
authorized representative, you will within thirty (30) days fully document and certify that
use of any and all Software at the time of the request is in conformity with your valid
licenses from Acoem.

If you have any questions regarding this Agreement or if you wish to request any information
from Acoem please use the address and contact information included with this product.
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3 Manual Revision History

Ecotech Manual ID M010043

Current Revision 1.9.0
Date Released August 2023
Description User Manual for the Airodis Environmental Data Management

Software Package

 Got a comment or suggestion for this manual? 
Please send your ideas to airodis.support@ecotech.com

mailto:airodis.support@ecotech.com.au
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4 Demonstration Version Limitations

The Airodis Demonstration version software has the following limitations:

· Station downloads are fully functional but can't be scheduled

· Report schedules can be set but can't be saved

· Report schedules will be cleared once per day

· Report output types are  limited to 
o PNG (Portable Network Graphic) images
o BMP (Bitmap) images
o JPG (Joint Photographic Experts Group) images
o GIF (Graphics Interchange Format) images
o TIFF (Tagged Image File Format) images

· Report output is watermarked

· A limit of three stations is imposed for a workspace

· Data can be validated but changes can not be committed to the database

· The services are confined to the local host machine i.e. you can not run a Distributed Client
install with a Demo Server

http://en.wikipedia.org/wiki/Portable_Network_Graphics
http://en.wikipedia.org/wiki/BMP_file_format
http://en.wikipedia.org/wiki/JPEG
http://en.wikipedia.org/wiki/Graphics_Interchange_Format
http://en.wikipedia.org/wiki/Tagged_Image_File_Format
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5 Demonstration Material

Airodis comes with data for a couple of demonstration stations and a number of example
reports. Along with the bundled demonstration data a number of tutorial videos are available
online.

This video information box will contain a link to a video
relevant to the section of the help file it appears in.

Downloading Videos

The videos linked to in this help file can also be downloaded and referred to offline. The
video bundle is a zip file containing the training videos and an index document which acts as a
menu.

See the Airodis web site (www.airodis.com) for download details.

Using the Demonstration Material

The following instructions assume that the option to install the Demonstration Database was
selected when Airodis  was installed.
If this option was not selected then rerun the Airodis installer with just this option selected.

1. First import the demonstration database data as detailed here: Client->File Tab->Import
Station->Demonstration Stations

2. This should result in a workspace with two stations: Ooze Lake and Mount Hazelton
3. The example Report files would have been copied in place when Airodis was installed
4. You should be able to see all of the Reports in the Airodis Example Reports folder when

viewing the files in the Report Manager. 
5. The Station ID's are important here, they are used to link the Station to a Report, when

loading an example report you may get this error if the Station ID's don't match: Report
Manager->File Tab->Open File

6. Simply follow the instructions and renumber the Stations in the Report to match the
Station ID in the Client application 

Throughout the manual you will see this icon detailing an
example report which is relevant to that particular part of
the manual.  

http://www.airodis.com
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 Remember when running the example Reports that the
demonstration data will end at the end of the month
preceding that in which the data was imported. Check in the

Client application if there is data for the required report period and
run the Report at a specified date if required.

For details on using the demonstration material see this
short video : Demonstration Stations

http://download.ecotech.com/Airodis%20Media/Media/Getting%20Started%20-%20Demo%20Stations/Getting%20Started%20-%20Demo%20Stations.html
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6 Installation and Setup

6.1 System Requirements

Airodis has been designed to run on a modern operating system, using modern networks and
hardware. The software fully supports 
UAC (runs without admin rights), IPv6, and runs natively in a 64-bit multi-threaded
environment.
Airodis can be used in a wide range of configurations, from single user and single station
setups to multiple stations with multiple Distributed Client installations.

Operating System Service Pack 32 bit 64bit

Windows 10 -- Y Y

Windows 11 -- N Y

Windows Server 2016 -- N Y

Windows Server 2019 -- N Y

Windows Server 2022 -- N Y

Processor: Recommended 2.0 GHz or faster

RAM: 2GB or more

Hard Drive Space: Airodis < 100MB

SQL Server Support: Airodis is designed for use with Microsoft SQL Server 2014 and newer.

Please see the web site (www.airodis.com) for more detailed system requirements, these
may change depending on how Airodis is used.

If you choose to configure an existing SQL server on the same machine, the DB Config Utility
(run at the end of the installation) will create the database 
and configure its permissions automatically. SysAdmin (sa) access is required during
installation.
If you choose to configure an existing SQL server on a different machine, please ensure that
SQL server has been configured to allow TCP connections 
and any firewalls have been configured accordingly (see required firewall ports below).

USB Support: Airodis  uses a USB dongle for copy protection. Please ensure that your hardware
can access a USB device. 
If you are running on virtualised hardware, it must support USB pass-through. Acoem
Australasia has confirmed this works on 
VMWare vSphere 4.1 and later, and VMWare Workstation.

http://www.airodis.com
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Connectivity to loggers and Instruments in the field: The  Airodis Download Server
communicates directly with loggers and instruments in the field. 
 Airodis supports connections over TCP/IP, Dial-up (direct modem connections and RAS), Serial
(RS-232) and USB (on selected loggers). 
 Airodis can also import data from files on a local hard drive or a Windows network share
(SMB/CIFS).
For TCP connections please ensure that the  Airodis server can establish a direct connection to
the logger or instrument.
For file imports please ensure that the local Network Service account on the server has read
permissions for the files to be imported. 
Alternatively, the  Airodis Download Server can be configured to run under a domain account
by modifying the properties of the Windows Service.

Firewall Exceptions: These ports must be open on the server to allow distributed clients to
connect. Both Airodis and SQL server operate on a dual-stack 
and support both IPv4 and IPv6. While it is ideal to enable both protocols where possible, it
will function on either of the two.
The Airodis installer can automatically open these ports on the Windows Firewall during
installation.
The Airodis DB config utility can be used to configure the Windows Firewall to automatically
allow traffic on the relevant SQL ports. 
The installer and DB Config Utility will only configure the software firewall on the local
machine - all hardware firewalls positioned between the server and a distributed
client will need to be configured manually

Note: For Airodis to automatically notify a user when an update is available, it must be able to
establish a connection to http://download.ecotech.com/. 
If the Airodis server’s internet connection uses a whitelist, please add this host to its
exclusions.

Port Protocol Listening Application Notes

46368 TCP4/TCP6 Airodis Server The main Airodis server. Required for
obtaining station lists, reason lists, reports
and licenses. A distributed client cannot
function without this.

46369 TCP4/TCP6 Airodis Download
Server

The Download Server. A connection is
required to get the download status of
stations and for the client to initialise
communication with a logger.

46370 TCP4/TCP6 Airodis Report
Scheduler

This connection is required for the Report
Manager to view and edit the report
schedule. It is not required to view, edit or
run reports from a distributed client.

3702 UDP4/UDP All Airodis server Workspace discovery subnet broadcast. This
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6 modules is only required for workspace auto
discovery to work on a local subnet. It’s not
essential, and will typically work out-of-
thebox because SSDP (Simple Service
Discovery Protocol) is allowed by default in
Windows Firewall. This protocol does not
support NAT
traversal, and should not be opened on an
external hardware firewall.

1433 TCP4/TCP6 SQL Server A SQL server connection is required to view
or edit data from the client, and to view or
edit reports locally.

1434 TCP4/TCP6 SQL Server Browser Required to connect to SQL server using
dynamic ports. Dynamic ports are used for
all non-default instances. A default instance
is named ‘MSSQLSERVER’. ‘SQLEXPRESS’ and
‘Airodis’ are considered named instances,
and dynamic ports must be enabled.

Windows Server 2012 R2 support and Windows 8.1 was
dropped in January 2023

6.2 Installing Airodis

Using the Airodis Setup Utility

As of version 5.0.6 Airodis now comes with an easy installer. The installation page can be
invoked by double clicking the 'index.html' file in the Web directory on the installation
media. 
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Installation Index Page

Click on the Install Airodis option to start the installer.

 To bypass the installer index page and start the setup utility
directly simply double click on the 'Setup.exe' file in the
Install directory on the installation media.

Note that all of the Acoem Australasia installers and utilities are
digitally signed for security.
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Airodis Installer

The installer presents the user with a number of installation types which are explained on the
right-hand-side of the dialog. 
The Database Type will change to reflect the default option depending on the Install Type but
is also user configurable (See also Which Database Should I Install?).

Every time the Install Type or Database Type is changed the list of Installation Steps will be
updated.
Clicking the Install button starts the installation, progress can be followed by checking the
Status column in the Installation Steps list.

The host machine may be required to be rebooted after certain installation steps, after the
reboot the Airodis setup will run  and the user can select the Install button to proceed to the
next installation step or  Start Airodis to start the Airodis application.

There are further options to install the Airodis Web Module component (this requires an
additional licence) and to upgrade from an existing WinCollect installation.

 Note that the Airodis setup utility will determine the host
operating system and install the correct files, either 32 bit or
64 bit, as appropriate for the platform.

Which Database Should I Install?

Airodis can be installed with a Microsoft SQL Compact edition database or optionally a
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Microsoft SQL Server 2019 Express edition database. The type of database to be installed
should be determined by the user according to how they are going to use Airodis. This choice
also determines which installation packages are required.

The Microsoft SQL Compact is a 'single file' database so this type of database is recommended
for single users on a single host machine. It could be used by multiple users on the same
machine, although not concurrently. For auditing, the name of the user currently logged on to
the machine will be used.
Microsoft SQL Compact can not be used for systems that have Distributed Clients, all Airodis
components must run on the same host machine.
The Microsoft SQL Compact database files have a maximum size limit of 4 GB.

For installations where there may be multiple users, Distributed Client installations and
concurrent users the Microsoft SQL Server 2019 Express database would be a better option.
The audit log would then use either the users Windows logon or a SQL logon.  



28 Airodis Manual

© Acoem and related entities 2023

Manual Installation using the Airodis Installation Packages

This section is aimed at the user who is not installing Airodis from the installation media but
have obtained the separate installation packages.  
If not installing manually then skip to Configuring Services.

Packages and Version Numbers

The Airodis install consists of two installation packages:

· Airodis Dependencies xxx.exe

· Airodis 5.yyy.zzz (xxx).exe

Where: 

· xxx is the target platform, x86 (32 bit) or x64 (64 bit)

· yyy and zzz are the Airodis release numbers

Installation with Microsoft SQL Compact

In order to install the Microsoft SQL Compact edition and Airodis, only the Airodis installation
package is needed. During the installation of Airodis if Microsoft .Net Framework 4.7.2 is not
installed on the host machine it will be downloaded and installed as part of the installation
process, an internet connection is required for this. 
This is the only dependency for this type of installation.

Installation order w ith Microsoft SQL Compact 

Installation order should be
performed as follows:

1. Ensure that the host
computer operating system
has the latest updates and
security patches installed.
2. Run the Airodis installer
package, download and install
Microsoft .Net Framework
4.7.2 if required. 
3. Reboot the computer once
installation is complete.
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Microsoft SQL Compact database files are stored in the  %
PROGRAMDATA%/Ecotech/Airodis/Database folder and
have the same name as the workspace they are associated

with.

Installation with Microsoft SQL Server 2019 and Dependencies

To install Microsoft SQL Server 2019 Express and  Airodis both the Airodis Dependencies and
Airodis installation packages are needed.

Installation Order w ith Microsoft SQL

Server 2019 Express and

Dependencies

Installation order should be performed as follows:

1. Ensure that the host computer operating system has the
latest updates and security patches installed.
2. Run the Dependencies installer package and reboot the
computer as required until the installer states that
installation is complete. 
3. Reboot the computer after Dependencies installation is
complete and then run the Airodis installer package.

The installation of the Airodis
Dependencies typically takes
around 20 minutes on a fast

machine, during which time the computer
will be unavailable for use.
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Airodis Dependencies Installation

The Airodis Dependencies installation package contains all of the software needed to get
Airodis up and running. 
It contains:

· Microsoft .Net Framework 4.7.2

· Microsoft SQL Server 2019 Express (and its dependencies)

If you have an existing Microsoft SQL Server database that can be used by Airodis then you do
not need to install SQL Server 2019 Express.

For a ‘normal’ install, all of the components in the Airodis Dependencies installer package are
selected to be installed by default. The installer will install the SQL Server 2019 detected
dependencies, SQL Server 2019  and Microsoft .Net Framework 4.7.2. Depending on which
components are installed the computer may need to reboot between installations of the
components. Please follow the installer prompts. When the computer has restarted and an
Administrator has logged in the installer will automatically resume for the user to continue
with the install.

It is generally good practice to reboot the computer after the Airodis Dependencies installer
has completed, whether the user is prompted or not. This is especially true if either Microsoft
.Net Framework 4.7.2 or Microsoft SQL Server 2019 Express were installed. 

It should be noted that on some platforms/configurations the Airodis Dependencies installer
may fail, particularly when installing Microsoft SQL Server 2019 Express. In this case the
installer will attempt to inform the user of the reason for the failure or direct them to an
installation log that may contain further information.

Microsoft SQL Server 2019 Express

The SQL Server is installed preconfigured. The database instance name is defaulted to Airodis.
The current user and all local administrators are added as a SQL administrators.

It is important that 'Windows' login is selected on the Workspace Manager before attempting
to connect to the database for the first time. Once the fields have been populated, save the
workspace using the File->Save Workspace menu option.
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Airodis Install

Note before installation. 
There is no Microsoft support for 64 bit Jet OLEDB 4.0 which
is needed to import legacy WinCollect 4 databases in the

WSL file format. If the user intends to import legacy databases on a
64 bit machine then they should install the 32 bit version of Airodis to
perform these tasks. Once the databases have been imported the 64
bit version of Airodis can then be installed.

Airodis is dependent on Microsoft .Net Framework 4.7.2 and if it is not detected on the target
machine then the user will have the option of downloading and installing it as part of the
Airodis installation.  (If the Airodis Dependencies Installer has not already been run) 
Airodis can be installed as a Full installation or Distributed Client installation (commonly
known as a Client install).

Installation Types

· Full installation: Installs all of the Airodis modules needed (this is the only
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installation type available for the Demo release). These modules are: the Workspace
Manager, Server, Download Server, Client, Report Scheduler and Report Manager. The
Full installation is the typical installation on a machine that will act as a server in the
system. 

· Distributed Client installation: Installs only the modules needed to run Airodis as a
Client. These are: the Workspace Manager, Client and Report Manager.

In addition to the two installation types the user also has the option of installing the
demonstration database. This database file contains two demonstration stations and data that
can be imported into Airodis.

Note after installation. 
Once Airodis has been installed and the Workspace
Manager started pressing the <F1> key in any of the

windows will bring up the CHM help file. 

http://en.wikipedia.org/wiki/Microsoft_Compiled_HTML_Help
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Configuring Services

The Server, Download Server and Report Scheduler can be run as Microsoft Windows services or
in a console. Normally these processes would be run as Windows services and require
configuring with appropriate credentials in order for them to do so.

In the Windows Component Services dialog the three services are named as follows:

Services

Select each service in turn and in the Log On tab configure the service with an account that has
the appropriate credentials to run the service. See Services: Log On Tab

Services: Log On Tab Services: General Tab

The services can also be configured to run automatically when the computer restarts by
selecting Automatic in the Startup type box. See Services: General Tab.
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6.3 Updating Airodis

When a new build version of Airodis is available it can be installed without having to uninstall
the previous version. There is no need to run the Dependencies Installer again.

The install should be performed by following these steps:

Updating Airodis

1 - If the Client or Report Manager are running then save any
changes and close them

2 - Stop the Download Server, Report Scheduler and Server
from the Workspace Manager

3 - Close the Workspace Manager

4 - Run the Airodis installer package

5 - Restart Airodis

There is an option in the installer to automatically start the
Services once they are installed. If this option isn't selected
in the installer and the Services are set to start automatically
(in the Services properties) then they will need to be
started manually from the Workspace Manager unless the
computer is rebooted

 If the Services are not stopped prior to an install then the
Airodis installer will automatically stop them before the
install commences.

 As of build 4568 Airodis has the ability to check online for
updates. It is advisable to keep the Airodis software up-to-
date. New releases will often contain new features and

improved functionality.

6.4 Software Security

 Note that this section is relevant to the full version of
Airodis only.
The Demonstration version requires no dongle in order to

run.  
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In order for the Airodis software to run the security dongle needs to be plugged in to the host
machine running the Server component.

The dongle is a driverless USB device that will be recognised and installed by the operating
system the first time it is attached to the computer.

This dongle is used to licence both applications running locally and Distributed Client
installations.  

Licencing

Licencing on Virtual Machines

On Virtual Machines where there may be no physical USB port available to host the dongle
there are a couple of solutions that can be used.

Digi.com - AnywhereUSB

This is a USB over TCP/IP solution, and allows a USB hub to be given a network address that can
then be accessed from the virtual machines. 
See www.digi.com for more details of this product.

Acoem Australasia have tested the AnywhereUSB/5 G2 device, accessing it successfully from
the following virtual platforms:

http://www.digi.com
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· Microsoft Windows 7 x86 and x64

· Microsoft Windows Server 2008 x86 and x64

· Microsoft Windows Server 2008 R2 x64

Note that the above were all Virtual Machines running on VMWare vSphere 4.1.0. Additional
testing was completed successfully with the same machines running on VMWare Workstation
7.1.3.

FabulaTech.com - USB over Network

The 'USB over Network' software package from FabulaTech (www.fabulatech.com) has also
been successfully tested with the platforms detailed above.
This is a software only solution and a free 15 day trial is available.

This product allow the accessing of a USB device, plugged into a host computer, via the
network.

6.5 Database Roles

Airodis uses the SQL database to implement security roles in the system.

There are four roles available in the SQL Server:

Role Description

Administrator Airodis Administrator can Create tables and Procedures, Delete, Execute,
Insert, References, Update, Select and Alter data in the database

Editor Airodis Editor can Insert, Select and Update data in the database

Reporter Airodis Reporter can Select data from the database

Viewer Airodis Viewer can Select data from the database

The Client and Report Manager use these roles to determine what the user can access in their
respective windows.

Client

Function Minimum Role Required

Add New Station / Remove Station Administrator

Save Station List Administrator

Download Data / Cancel Download Editor

http://www.fabulatech.com
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Schedule Download Editor

Manage Reasons Editor

Import Stations Administrator

Add Database Administrator

Set Clock on Logger Editor

Add / Remove Channel Administrator

Add / Remove Vector Pair Administrator

Delete Data Editor

Apply Time Offset Editor

Commit Data Editor

Import Data from File Editor

Add Rule Administrator

Add Rule Condition Administrator

Add Rule Email Administrator

Report Manager

As the Report Manager doesn't write or alter data in the database there is no difference
between the Editor and Reporter roles but the Viewer role is restricted.
As a Viewer the user is able to open Reports and Schedules and make changes to them but
these changes can not be saved.



Database Management

Part

VII



39Database Management

© Acoem and related entities 2023

7 Database Management

Microsoft SQL Server 2019 Express is limited in terms of automated database backups which
are present in the fully licensed versions. 

To get around this limitation Acoem Australasia recommend the use of a free tool called
SQLBackupAndFTP which can be downloaded from here: http://sqlbackupandftp.com.

This software is recommended for any users running the Express version of SQL Server. Users
running the fully licenced version of SQL Server should have their own database backup and
restoration processes in place.

Features

Note that some of these features are only available in the paid version of the software.
SQLBackupAndFTP enables the user to run scheduled backups (full, differential or transaction
log) of their SQL Server Express databases. The free version is limited to scheduled backups of
two databases although an unlimited amount of databases can be manually backed up.

The software can also run file and folder backups, it can zip and encrypt backups and store
them locally, in a network folder, on a FTP server or in the cloud.
In addition it can also remove old backups and send email notification confirmation when a
scheduled job is finished.  

Databases can be restored from backup using the one click restoration tool.

Installation and Setup

Installing SQLBackupAndFTP is easy. Just download the installer from the link shown above,
run it and follow the prompts.

Setting Up Backups

See the tutorial shown here: http://sqlbackupandftp.com/tutorial/  to get up-and-running.

Airodis File/Folder Backups

http://sqlbackupandftp.com
http://sqlbackupandftp.com/download/SqlBakSetup.exe
http://sqlbackupandftp.com/tutorial/
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There are specific Airodis files and folders that should be backed up as well as the database.

1. Workstation files: Found in the %APPDATA%/Ecotech/Airodis/Workspace Manager
directory

2. Station and Reason Lists: Found in the %PROGRAMDATA%/Ecotech/Airodis/Server directory
3. Report Files and Templates: Found in the %PROGRAMDATA

%/Ecotech/Airodis/Server/Reports directory
4. Report Template Files: Found in the %PROGRAMDATA%/Ecotech/Airodis/Server/Templates

directory
5. Report Schedules: Found in the %PROGRAMDATA%/Ecotech/Airodis/Report Scheduler

directory
6. Downloaded Data Files: The directory for which is specified in the Client application

If using Microsoft SQL Compact database then these
database files can be found in the  %PROGRAMDATA
%/Ecotech/Airodis/Database directory. They can be backed

up and moved like any other file once Airodis has been closed down.

The system %APPDATA% and %PROGRAMDATA% folders are
platform specific and differ between different versions of
the operating system. To find out where the folder is on your

system just type %APPDATA% or %PROGRAMDATA% into the address
bar in Windows Explorer. Note too that these folders may be hidden
by default, you may also need to change the Windows File/Folder
'Show Hidden Folders' setting.   
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8 Workspace Manager

The Workspace Manager is the control panel for all of the Airodis components.

There is a dropdown list on the bottom left-hand-side of the Workspace Manager window
that allows the user to switch between different languages.
Note that on changing the language selection the Workspace Manager will be restarted but
the Client and Report Manager, if running, will need to be restarted manually.

Workspace Manager (Collapsed)

Processes Tab

The Processes tab displays the current status of each component. When a process icon is
highlighted it signifies that the process is running.
The user may click on a process icon to start or stop that process.

The Launch Workspace icon will start all of the components if they are not already running.

Using the Workspace Manager to stop the Client or Report
Manager components will result in those components
closing immediately and unsaved changes may be lost. It is

better to close these components from within their respective
windows.

File Tab

The File tab is used to create New workspaces, Open existing workspaces and Save workspace
changes. 



43Workspace Manager

© Acoem and related entities 2023

Workspace Manager File Tab

When selecting New Workspace the view will change to the Processes tab and the Workspace
Name field will be highlighted. 
By default the new workspace name is set to Airodis but can be changed, when the workspace
details are filled in the new workspace can be saved by using the Save Workspace menu item. 

 
It is advisable to have unique workspace names on the
network to avoid confusion.

The Workspace Manager gives an overview of the
Workspace Manager functionality.

8.1 Extended Functionality

The Workspace Manager window can be expanded to display a number of additional
configuration items.

http://download.ecotech.com/Airodis%20Media/Media/Getting%20Started%20-%20The%20Workspace%20Manager/Getting%20Started%20-%20The%20Workspace%20Manager.html
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Workspace Manager (Expanded)

Item Functionality

Workspace Name This is the name of the currently loaded workspace. Use the
dropdown box to select another workspace that may have been
discovered on the network. See Workspace Discovery.

Database Type Select Local File for Microsoft SQL Compact (single database
file) or SQL Server for a Microsoft SQL Server database

SQL Instance This is the name of the Microsoft SQL Server instance to
connect to (unavailable when using Local File)

Database Authentication Authentication for logging onto the database, either SQL or
Windows (unavailable when using Local File)

Server Hostname The host name of the machine that the Server component is
running on. In this case the Server is running on the same
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machine as the Workspace Manager. If the user selected a
workspace detected on the network then this box will show
the name of that machine instead.

Server Port The port number that the Server component is communicating
on.

Run in console If ticked the Server component will run in a console and the
user will be able to view diagnostic messages that are
produced. If unticked the Server will run as a service. See
Configuring Services.

NOTE: The Hostname, Port and 'Run in console' items above also apply to the Download Server
and Report Scheduler.
These items should not be changed unless advised by an Acoem Australasia employee.

 Database authentication is unnecessary when using
Microsoft SQL Compact Edition (Local File), the user name of
the person currently logged into Windows will automatically

be used for all auditing purposes within the database.

8.2 Workspace Discovery

An Airodis workspace will broadcast its presence over the network. In this way a Client may
connect to another workspace on the network without the user having to manually configure
the settings. 

Use the Workspace Name dropdown box to select another workspace that has been detected
on the network.
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Workspace Discovery

In order to turn off this discovery mechanism launch Airodis
with a /nodiscovery command line argument. This can be
achieved by editing the Target field of the Airodis desktop

icon.
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9 Client

9.1 Overview

The Client component is used to manage Stations and data.

Follow these steps to add a new Station, Acquire its configuration and Download data:

Add New Station Workflow

File->Add Station in the File tab or Home->Add Station menu
item in the Home tab

Set the station parameters in the Station tab

Save the station details using the Home->Save Changes
menu item or the Quick Access toolbar

Acquire the logger configuration  using the Station->Acquire
Configuration menu item

Check report intervals in the Station tab and channels in the
Channels tab

Save the station details using the Home->Save Changes
menu item or the Quick Access toolbar

Download data using the Home->Download menu item or the right-click menu item on the
station

9.2 File Tab

The File tab offers access to the following functionality:

Item Description

Add Station Adds a new Physical or Virtual Station. The view will then change to the
Station tab where the station details can be entered.

Save Changes Saves any changes made e.g. Stations added
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Dismiss Changes Dismisses any changes made since the last Save operation or the
application was started

Reason List Opens the Reason List dialog 

Import Stations Opens the Station Import dialog

Options Opens the Options dialog

Exit Closes the Client application

Adding a Station details the process of adding a new
physical station. 

9.2.1 Import Station

WinCollect 3/4 stations can be imported into Airodis using this tab.

Import Stations Dialog

Source

http://download.ecotech.com/Airodis%20Media/Media/Getting%20Started%20-%20Adding%20a%20Station/Getting%20Started%20-%20Adding%20a%20Station.html
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Current Database

Select this option if you have an existing WinCollect 3/4 SQL Server database that you want to
use with Airodis. The stations will be imported into Airodis giving the user full access to all of
the functionality with the existing stations and data. 

WSL/WSQ File

If the user has an existing WinCollect format WSL or WSQ file then the stations and data can be
imported from this file into the new Airodis database.
1. Select the file that you would like to import from
2. Tick the Import Data box if data import is required
3. Select the Open button, a list of stations in the file will be shown
4. Select the stations to be imported
5. Select Import
6. The stations are imported, when a station has been imported it is greyed out in the list
7. When all stations are imported select the Close button to dismiss the dialog
8. Select the Stations tab to check the stations and Save or Dismiss the changes as required

When importing stations from a 'live' database, i.e. one still
being used by WinCollect 3/4, ensure that WinCollect has
been closed before proceeding otherwise the database file

may be locked and inaccessible.

Once a station has been imported and the station list saved
the user may at some point delete that station and wish to
import it again. When a station is deleted its database tables

remain so the database administrator will be required to manually
delete those tables before the station can be imported again. 

There is no Microsoft support for 64 bit JET OLEDB 4.0
drivers. 
SeeTroubleshooting Tips -> Client -> Station Import.

Demonstration Stations

Airodis ships with a demonstration database from which two stations and their data may be
imported. This is a useful exercise if the user would like to play with Airodis and explore its
functionality but do not have any instruments or data of their own. The demonstration data is
imported automatically.
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Import Stations Dialog - WinCollect 3/4 Database File

Follow the steps detailed above to import the demonstration stations as you would for a
WSL/WSQ file.

 Create a new 'demonstration' workspace to import the
stations into, by doing this the demonstration stations are
not mixed with production stations.

On import the demonstration data date range is altered so
that the data ends at the end of the month preceding the
import (current) date. 

Demonstration Stations shows you how to import the
demonstration stations and data and view that data.

http://download.ecotech.com/Airodis%20Media/Media/Getting%20Started%20-%20Demo%20Stations/Getting%20Started%20-%20Demo%20Stations.html
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9.2.2 Options

The Options dialog contains a number of tabs enabling the user to set global options, view
information about the installed version of Airodis and send Support Requests.

Global Options

The Global Options tab is where the user can set up email settings for sending Support
Requests, Alarms or Reports.

Global Options Tab

Mail Settings
See Setting up email for using this feature.

Download Server

Item Description

Download Path This is the top-level path to where the downloaded data will be stored. A
directory is created for every station and its data stored within.
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Communication
Logging

Select this box if communication logging is to be enabled.

Maximum Clock
Drift

When automatic time synchronisation is enabled the logger clock will be
synchronised only when it drifts by this amount. Specifying a low number
in the order of a couple of seconds can be detrimental to the
performance of Airodis.

Concurrent
Downloads

The maximum number of concurrent downloads allowed. This can be
configured by the user depending on their hardware specification.

 Communication logging is the logging of all communication
between Airodis and the equipment it is communicating
with. This logging is turned off by default and should only be

turned on if advised to do so by an Acoem Australasia employee, as it
has the potential to slow down the system.
Communication logging is usually only turned on when
troubleshooting a download problem.

The Maximum Clock Drift time should be set between 15
seconds and 15 minutes. A 'drift' of over 15 minutes may
indicate a more serious problem and Airodis will not correct

it.

Unit Conversion

The default temperature used in the unit conversion process can be specified here. Options
are 0, 20 and 25 degrees Centigrade and should be changed according the the users
requirement.

Licence Tab

This tab shows the licence details for the registered user. 
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Licence Tab

Item Description

Ecotech ID The ID of the Ecotech order number in the form of xx-xxxx

Dongle ID The ID of the software security dongle used with this system

Registered
Company

Name of the company/individual that the licence is registered to

Date of
Manufacture

The date that the software security dongle was programmed

Licence Licence details of the edition of Airodis that can be run, the number of
Stations that can be added, the number of Servers and Client seats

Upgrading a Licence

In order to upgrade a licence first a licence file must be obtained from Acoem Australasia, this
will normally be delivered via email. Each licence file is specific to the dongle ID that it has
been programmed for. The licence file is simply a XML file that must not be altered or edited
in any way, this will render the file useless.

Follow the following steps to update a dongle using the licence file:
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1. Obtain a licence update file from Acoem Australasia
2. Ensure that you have the latest version of Airodis running. See Checking For Updates.
3. Save the licence file on the host computer that the Airodis Server is running on
4. Open the Client application on that same machine and navigate to the Options -> Licence

tab
5. Select the Upgrade button on the tab and navigate to where the licence file has been

saved.
6. Select the licence file and click on the Open button
7. The dongle will automatically be updated with the new licence details
8. Once the update is applied restart the Airodis components to ensure that the licence

changes are propagated throughout the system

Should an error occur while updating the dongle details with
the new licence file, please contact the Acoem Australasia
Technical Support team.

About Tab

Details the version of Airodis that is running, its build number and build date. This is useful
information when contacting Acoem Australasia with any feedback.

Support

This tab enables the user to file a Support Request if they encounter difficulties when using
the software. Click on the File Support Request button to do so.
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Support Tab

To determine if there is a newer version of Airodis available the user can click on the Check
For Updates button. Note that the host computer must be connected to the internet in order
to do this.

9.2.2.1 Filing a Support Request

The File Support Request button enables the user to send details of the system and software to
Acoem Australasia when there is a problem. 
The Airodis Support Request functionality can use a local SMTP server to send emails, see
Setting up email, or it will attempt to use
the Acoem Australasia SMTP server.

Details Tab
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Support Request Details Tab

The Details tab shows the details that Airodis has collected about the system. These include:

· Environment Details
o General machine and platform details
o SQL connection status, security and user details
o The Server connection status, its host name and port details
o The Download Server connection status, its host name and port details
o The Report Scheduler connection status, its host name and port details

· Licence Details as shown in the Licence Details tab

These is also space at the top of the tab under Issue Description where the user may include
additional details about the problem.

Attachments Tab
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Support Request Attachments Tab

On the Attachments tab the user is able to select which Communication Logs and/or Reports
need to be sent with the support request. In order for Communication Logs to be sent
communication logging needs to be enabled (See Enabling Communication Logging)

By default the Attach Station List and Attach Event Logs are selected and should always be
sent with any support request.

Clicking on the Send button will attempt to send the email and attachments via a SMTP server.

9.3 Home Tab

The Home tab offers some of the functionality of the File tab but also has functionality specific
to the selected Station.  
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Home Tab

Item Description

Add Station Adds a new Physical or Virtual Station. The view will then change to the
Station tab where the station details can be entered.

Delete
Station

Deletes the selected Station from the station list. This function will not delete
the Stations tables from the database. 

Save Changes Saves any changes made e.g. Stations added

Dismiss
Changes

Dismisses any changes made since the last Save operation or the application
was started

Show/Hide Shows or Hides the selected Station(s). Hidden stations can be viewed by
selecting Show Hidden Stations menu item

Groups Enables the user to show a Group, add the selection to a new Group or remove
the selection from a Group

Download Shows the Download Data dialog

Cancel Cancels the download for a selected Station or Stations

Schedule Shows the Download Scheduler dialog for the selected Station

Download Log Shows the Download Log dialog for the selected Station

Download Data

Download Data Dialog
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This dialog enables the user to specify  the data range that is required for downloading. 
Downloads will either commence from the Last Data Point to the present time or a date range
specified by the user.

The Last Data Point is the date of the last data found in the database.
Some instruments have a finite memory so the user may wish to clear the logger memory
when the download has finished. This should be used with extreme care as data deleted from
the logger can not be recovered.

Schedule

Download Scheduler Dialog

The Download Scheduler enables the user to schedule downloads for the selected Station. 

Item Description

Next Download The date and time when the next download is scheduled for

Increment The time between downloads in weeks, days, hours or minutes

Keep Logger Clock
Synchronised

Set the logger clock to the same date and time as the system clock. This
will be applied if the logger clock drifts by an amount greater than or equal
to the time set in the Global Options Maximum Clock Drift settings.

Clear logger on
successful download 

Clear the logger memory once a download is finished (use with extreme
care)

Enable schedule Enable the schedule once OK is selected

Download Log
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The Download Log dialog displays a summary of the last 10 download tasks and their results.
Download tasks include:

· Download

· Acquire Config

· Get Logger Clock

· Set Logger Clock

The Result field will detail the outcome of the task while the Records Imported field displays
that number of records.

The status icon colours denote the following:

No download from the logger or there was an error while downloading
The logger responded correctly but there were no records to download
All available records for the selected download range were downloaded without incident
An alarm was raised during the download

Hover the mouse cursor over the status icon in the Home tab
to see details of the last download.
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9.4 Station Tab

Station Tab

Menu Items

Item Description

Acquire
Configuratio
n

Acquires the configuration of the logger for the selected station. The Channels
tab and Reporting Intervals will be populated if the configuration is acquired
successfully. If the Station already has configuration settings the user will be
given the option of overwriting or merging the existing settings.

Set Logger
Clock

Opens the Set Logger Clock dialog. The user may then synchronise the logger
clock with the system clock or set the clock manually

Remote
Control

Opens the Remote Control dialog for the selected Station

Add/Remove
Database

Opens the Add/Remove Database dialog

Download
Directory

Opens a Windows Explorer dialog showing the download directory for the
selected Station. The download directory is where the download files are kept
as well as communication logs if logging is enabled

Set Logger Clock



63Client

© Acoem and related entities 2023

Remote Control 

Remote Control Dialog

The Remote Control dialog allows the user to send commands to the logger and test
connectivity. Not all options are available for all loggers.
Use the Ping button to send a ping command if the logger has a TCP/IP connection.

http://en.wikipedia.org/wiki/Ping
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Commands can be typed into the command box at the bottom of the dialog and sent using the
Send button.
Where supported the command box will supply a list of common commands for that logger
type.

Add/Remove Database

 When talking about data storage the terms 'database' and
'tables' are used interchangeably for legacy reasons. In
Airodis we are actually adding Tables associated with a

Station to a database, not a new database per Station.

Add/Remove Database Dialog

To add a new database for the selected station select the Add/Remove Database menu item
to display the Add/Remove Database dialog.
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The dialog shows the currently selected Station and its associated database in blue text, it also
displays the other tables in the database that are not currently associated with a Station. To
associate the current Station with a new database simply enter the new database name in the
text box and select Save and Close.

To see which databases are associated with other Stations tick the Show All Databases box,
the dialog will change as follows: 

Add/Remove Database Dialog showing all databases

If the user attempts to associate the current Station with a database that is already in use with
another Station the following warning will be given:
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Warning - Database Already In Use 

To delete a database select a database from the list and select the Delete button.  The
following warning will be given: 

Delete Database Warning
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 Deleting a database will PERMANENTLY remove the
database tables and data. There is no way to get the tables
or data back once they have been deleted. This feature is

restricted to users with Administrator privileges and should be used
with extreme caution. 

 Allowing a Station to move between databases is helpful if
the instrument moves location, in this way the user could
have a database per location for that instrument.

Other users may want to have a database per time period so a new
database could be created and used every month or year.

Database Manipulation demonstrates advanced database
use. 

9.4.1 Station Parameters

The Station Parameters are split into four distinct sections:

General Parameters
General parameters for this station, some parameters are optional.

Item Description

ID Some loggers require/support a logger ID. If the logger does not support or
require an ID this field will be disabled

Station
Name

(Optional) A meaningful name for this Station

Company
Name

(Optional) The company name that this station belongs to

Logger Select the logger type from the dropdown list

Time Zone Select the required time zone that the logger is in from the dropdown list

Change
with DST

Tick this box if the logger clock changes with Daylight Savings Time

Latitude (Optional) The latitude of the station

Longitude (Optional) The longitude of the station

Elevation (Optional) The elevation of the station

Reporting Intervals

http://download.ecotech.com/Airodis%20Media/Media/Advanced%20-%20Client%20-%20Database%20Manipulation/Advanced%20-%20Client%20-%20Database%20Manipulation.html
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This window shows the report periods set on the logger. These values are obtained when the
configuration is acquired from the logger.

For a WinAQMS logger the report periods can not be
obtained automatically and the Reporting Intervals will be
populated with default values. These should always be

checked manually to ensure that they are correct and changes made
if they are not. 

Data Parameters

This window shows the current database name that the station is using. The Add/Remove
Database menu item must be used to add a database.

Communication Parameters

The Communication Parameters window defines the connection between Airodis and the
logger. The fields available will change depending on the Link type.

Item Description

Device Id Some loggers support an identifier, enter it here so that it is used in the
communication protocol.

Device
Password

Some loggers support a password. If the logger supports a password then the
default one will be used unless this field is populated.

Argument
s

Optional arguments that may be required by the communication protocol. See an
example here.

Link Type The connection to the logger: TCP/IP, Serial, Modem, File

TCP/IP Link:
Item Description

IP Address The IP address of the logger

Port The port number that the logger is using. Some loggers (e.g. WinAQMS) use
default ports, if this field is not populated then the default will be used 

Serial Link:
Item Description

COM Port The COM Port that the logger is connected on
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Baud Rate The Baud Rate, 1200 to 115200

Data Bits The number of Data Bits used, 5 to 8

Parity Parity used, Even, Odd, Mark, Space or None

Stop Bits The number of Stop Bits used, one, one point five or two

Modem Link:
Item Description

Device Select Any or a specific modem installed on the system

Phone
Number

The telephone number to be dialed. This field also supports commands from the
Hayes AT command set such as 'W' for Wait and ',' for Pause if they are supported
by the modem.

Dialup
Type

Direct Modem or Dialup Networking. The following fields are for Dialup
Networking only

Username Networking user name

Password Networking password

Logger IP
Address

The IP address of the logger to connect to

Logger
Port

The port number the logger is using

File Link:
Item Description

Import
Source
Directory

The directory containing the source files. If this is a network drive the address
will be converted to a UNC address.

Filename
Filter

Use this field to filter the data files from any others that may be in that directory

Arguments:
Available arguments for communication will be shown in a tool-tip when hovering over this
field. Clicking on the field will display a popup window with more details of the parameters.

http://en.wikipedia.org/wiki/Hayes_command_set
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Communication Arguments

Changing the arguments and selecting OK will pre-fill the Argument field.

Pre-filled Arguments

9.5 Virtual Station Tab

Virtual Stations allow the user to manage channels from multiple stations as if they were on
the same station. This tab is only visible for stations added to the list as a Virtual Station. A
Virtual Station can also have its reports published over the Modbus protocol.
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Expand the Stations list to select the Reports or Channels from each Station that will make up
the Virtual Station.
Drag the selected Reports or Channels across to the Virtual Reports window to populate the
list. Unwanted Reports or Channels can be removed by using the Remove Channel menu item.
Additional Report tabs can be added using the Add Report menu item. Unwanted Report tabs
can be removed using the Delete Report menu item. 

When viewing a Virtual Station from the Data Manager tab, channels from different reports or
stations can be graphed and edited side-by-side. This makes it easier to perform comparisons
while validating and editing data. Extra column headers are added to show the station and
report for each included channel.



72 Airodis Manual

© Acoem and related entities 2023

9.6 Channels Tab

Channels Tab

Channels

The Channels tab details all of the channels associated with the selected Station.

Channels can either be manually created and deleted using the Add Channel and Delete
Channel menu items or acquired from the logger directly.
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Item Description

No Channel number

Label The channel label that is used in Airodis

Logger Channel
ID

The channel identifier on the logger, this may be a number or a label

Units The channel units

Molecular
Formula

The molecular formula used to convert between units

Decimal Places The number of decimal places required for this channel

Description A free text description of the channel

Colour The colour associated with this channel. This colour will be used in the Data
Manager as well as in the Report Manager

Show Show or hide this channel

Vector Pairs

In the Vector Pairs tab the pairing is achieved by selecting the Wind Speed and Wind Direction
from the list of Channels available on the Station.

Pairs can be created and deleted using the Add Vector Pair and Delete Vector Pair menu items.

9.7 Data Manager Tab

Overview

The Data Manager tab allows data to be viewed instantly without the need to configure
reports.  Simply by selecting a station, choosing a period and pressing display, the Airodis
client will load data from the database to provide a tabular and graphical display of the
selected data.

From this tab, the user can download or import data, export data , invalidate, change and
delete data.

Data Manager Ribbon Controls
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Download

Data can be downloaded from here making it convenient to look at the latest data without
having to change the view to the Home tab.

File Import

By selecting File Import the user can access the import wizard. This works in the following way:
1. Select a Filename and Format Type
2. Enter the Date Range, either downloading from the Last Data Point or Specify a date range
3. Select Acquire to retrieve the detected channels from the file, these can be compared to

those set in the Station
4. It is not necessary for the file to match the expected column order, or for all parameters to

be present, as only those matched to a defined channel will be imported.
5. The Report dropdown box enables the user to select the report data that they want to

import. In file types in which there is no report information the  data is imported into the
report shown in this box

Import Data Dialog
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 Note that on clicking the Import button that the actual
file(s) to be imported are sent to the Download Server. A
dialog will be displayed indicating the status of the actions

performed, this does not indicate the number of records imported!
To see the result of the import function check the Download Log for
the Station in question.

Export

The Export function allows quick export of data from the database to a number of file formats.
By following the prompts the user can define any given period from the selected report, or
highlight a section of data  which will configure the exporter automatically.
Export formats include: CSV, XML and EPA Text files.

 
The EPA file format is that of the Victorian Environmental
Protection Agency

Display Data
Clicking Display will load data from the selected station.  The period required should first be
selected in the date and time selector to the left of the icon.  

Check Contiguity

This feature allows a quick visual check of the data to look for gaps or non contiguous data.
Contiguous data is shown as green whilst missing values are shown in white.  The table on the
right shows the periods of missing data for reporting purposes.
By default, the period selected in the Data Manager is scanned but the dialog allows for the
period to be changed and the scan run again.
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Contiguity Check Dialog

Delete

The Delete function allows the user to select a period of data to be deleted by selecting data in
the Data Manager or by defining a period manually.  
From the Delete Data dialog the user can choose to delete all or just certain parameters.  

Delete Data Dialog
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Time Offset

Occasionally equipment may be set to the wrong time (often due to daylight savings) but this
is no longer a problem as Airodis comes with the Time Offset feature.  
The data between the From and To date for the selected Report will have its timestamp
altered by the value in the Offset box.

Time Offset Dialog

View Options

View Options provides a set of filters for viewing the data. For example a data set with a very
high value due to a fault would be difficult to graph as the graph would auto scale to the very
high value.  Provided the value has been invalidated, by deselecting the invalid filters, the
graph will show only good data and therefore apply more realistic axes.
As changes may have been made to the data but not yet committed there are a range of filters
to cover all possible scenarios.

Colour Scheme

The colour scheme dialog allows the user to change the way that data is displayed in the Data
Manager with respect to the font and cell colours. 

Dock/Undock Graph
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The Dock/Undock Graph menu item detaches the graph window from the Data Manager and
enables the user to position that graph window elsewhere on their screen. This menu item is
a toggle so once undocked a click on the menu will dock the graph back in its original position. 

Validation Options

One of the main features of the Data Management tab is to allow the user to validate data. 

Data Validation explains the validation process.

Validation might involve editing data or simply marking certain points as invalid or even
revalidating data previously thought bad due to an error. All of this can be done in the Data
Manager and is achieved through the  use of the Reasons List.

Reason List

Airodis is supplied with a basic reason list containing common validation issues for different
site and instrument types.  This list can be added to by the user to either the site specific list,
general or instrument specific sub sets.  The Reason List can be found on the right-hand-side
of the Data Manager tab. Different reasons have different actions and these actions are
applied to the loaded data in the following way.

Reason - Drag and Drop

When a selection is made in the graph or table view, the data will be highlighted light grey.  By
selecting a reason and dragging it onto the highlighted data, the user can perform a number of
functions depending on the reason selected. To apply a selection to multiple columns, the
<CTRL><SHIFT> key combo can be used.

http://download.ecotech.com/Airodis%20Media/Media/Client%20-%20Data%20Validation/Client%20-%20Data%20Validation.html
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Reasons List and Parameters

The Reasons List will also show additional information depending on the reason that has been
selected. For reasons that change the data there may be a subset of values which can be
configured such as the size and direction of an offset. The user must change the parameter
field before the reason is applied.
Some reasons will invalidate data, some that apply offsets or multipliers will change the value
displayed. Reasons in the AQS reason list will apply AQS qualifier codes to data which will
appear in the output of AQS Reports.

To add a new reason item click on the Reason List icon that can be found in the Validation
menu group at the top of the Data Manager tab. 
Reasons can be added as either an Instrument or Station type. Once a Reason has been added
it can not be deleted as it may appear in the audit history.
If an AQS code is specified, AQS Reports will add the code to its qualifier list.

Reason Dialog - Instrument Reason Reason Dialog - Station Reason

All changes made to the data will be logged in the Audit tab and can be discarded or undone
until committed.
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Commit Changes

As the Client loads data from the database, no changes made will be applied to the database
until they are committed. Once data is committed, the only recourse is through using the
Revert function to restore it to its previous state. 

Undo

The Undo feature allows uncommitted changes to be reversed and can support multiple
successive undo actions.
Select the Undo icon to undo the last change or use the dropdown arrow below the icon to
choose an change that was not the last change made.

9.7.1 Data Graph

The Data Graph displays the data selected in the Data Manager cells. 
Selecting a column or multiple columns by clicking on the column header will display all the
data in the column(s) for the defined period.

The Data Graph can also be undocked by using the Data Manager Undock Graph menu item
and freely positioned and resized anywhere on the the screen.
To re-dock the graph again just close the graph window and it will resume its original position. 

Data Graph Undocked

Use the cross hairs to zoom into a particular region of the graph.
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Data Graph Zoomed

 An 'unzoom' operation can be performed by either selecting the magnifying glass menu item
that appears in the top right-hand side of the dialog or using the "-" minus key on the
keyboard. Multiple "unzoom' operations can be performed until the graph is displaying its
original data.

The Data Graph also has an extensive right-mouse click menu that gives a number of user
configurable options.

Right Mouse Click Menu

The Data Graph can be exported in a variety of formats via the Export Dialog menu item.
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Data Graph Export Dialog

9.8 Audit Tab

Airodis tracks all changes made to data by the user.  To view the change history, select the
station in the Home view and select the Audit tab.

Audit Tab - Select Audit Report Date Range

From here, you can search by date to produce a list of all changes made including the user, the
reason, channels affected etc.  

Selecting an audit entry in the list displays a list of modified cells and their previous values
and status values.
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Audit Tab - With Audit Entry Selected

Selecting the View Data menu item will take the user to the Data Manager tab which will
display the corresponding audited data for the row selected.

9.9 Rules Tab

Conditional Rules Tab

This section allows rules to be configured to auto invalidate data and/or send messages by e-
mail., e.g. in the event of a pollution episode or instrument fault.  
The first step is to create a new rule using the “Add Rule” button

With a suitable mail to SMS provider, SMS alarms can be
generated to quickly notify individuals who may not have
access to e-mail.

Conditions

Conditions

Conditions can then be added to the rule based on single or multiple channels by selecting
preconfigured options from a dropdown list.  The user must also set the time interval the
condition will be applied to which need not be the same as the downloaded data (but should
be a multiple)

Multiple conditions can be added to build more complex scenarios. 

http://en.wikipedia.org/wiki/SMS
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Invalidate Channels

Invalidate Channels

Once set, the user can choose what action is to be taken when the conditions in the rule is
met.  This can include invalidation of selected parameters and or, sending messages to
multiple recipients.

Send Email

Send Email

The messages themselves can be in detailed or short form depending on whether e-mail or
SMS is being used. 
Rules and recipients can be enabled and disabled independently for greater flexibility.

Options 

Options

For each rule, the subject line of the message can be edited as required. The report and data
options can also be set here. It is also possible to limit the number of alarms that are sent in
succession, and the time window in which they can be sent. 

Item Description

Email Subject The subject line to use for outgoing email when this alarm is raised

Alarm Window
Start Alarm

The time of day (in the station's time zone) in which alarms notifications can
be sent. If the start time is after the end time, it will be assumed that the
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Window End alarm window crosses midnight.

Max Alarms The maximum number of notifications to send in succession for a
continuous alarm event.

Email Cleared When enabled, an additional email notification will be sent once the alarm
condition has been cleared.

Report The report which for which the alarm rules apply.

Include Bad
Data

When enabled, bad data (including calibration data) will be included in the
calculations. Disable this if rules should only apply to genuine instrument
readings.

Minimum
Capture %

The minimum capture that is required for an alarm condition to be
evaluated. This is based on the number of records imported and the
expected number of records according to the report interval.

Calibration Rules Tab

The Calibration Rules follow the same format as the Conditional Rules detailed above, the
difference lies in the Options tab.

Options

Options

The Options tab allows the user to set the thresholds for invalidation and alarms. The
calibration type, report and channel associated with this rule are also selected here.

Item Description

Calibration Type Zero: The channel is expected to have a near-zero value.
Short term span: The channel is compared to the previous span value.
Long term span: The channel is compared to the corresponding precision
value.

Calibration
Channel

The channel to evaluate

Alarm
Threshold

The drift threshold at which an alarm is raised. For a zero alarm, this is an
absolute value. For span alarms, this is a percentage.
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Alarm
Threshold

The drift threshold at which data is flagged as invalid. For a zero alarm, this
is an absolute value. For span alarms, this is a percentage.
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10 Server

The Server component is usually run as a Windows service. See here for details on how to set
the service up.

Server Connectivity

The Server connects to and communicates with other components as shown below:

Server Connectivity



Download Server

Part

XI
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11 Download Server

The Download Server component is usually run as a Windows service. See here for details on
how to set the service up.

It's main function is to schedule downloads and download data. 

Download Server Connectivity

The Download Server connects to and communicates with other components as shown below:

Download Server Connectivity



Report Scheduler
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12 Report Scheduler

The Report Scheduler component is usually run as a Windows service. See here for details on
how to set the service up. 

Its main functionality is to schedule reports.

Report Scheduler Connectivity

The Report Scheduler connects to and communicates with other components as shown below:

Report Scheduler Connectivity



Report Manager

Part

XIII
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13 Report Manager

13.1 Overview

The Report Manager is used to edit and schedule new or existing reports.

Report Manager Overview

The Report Manager Overview video gives a brief tutorial on
aspects of the Report Manager functionality.

Work Flow

Quick Start for New Reports

The New Report Wizard can be used to quickly create a new report.

 
Double clicking with the mouse on an existing report object
opens it for editing.

For New Reports

http://download.ecotech.com/Airodis%20Media/Media/Report%20Manager%20-%20Overview/Report%20Manager%20-%20Overview.html
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1. Create a new report in the File tab
2. Select the Stations, Reports and Channels to be used in the new report from the Stations

tab
3. Edit the report by adding report objects from the Edit and Calculated Channels tabs and

define report layout options in the Layout tab
4. Save the new report as a report or a template in the File tab
5. Schedule the report in the Scheduler tab

For Existing Reports

1. Select the report to open in the File tab
2. Edit the report objects in the Edit, Layout and Calculated Channels tabs
3. Save the results
4. Schedule or change the scheduling settings in the Schedule tab

Report Manager Interaction

This message trace diagram shows how the Report Manager interacts with other components.

Messages

13.2 File Tab

The File tab is used to Create new files, Open existing files or templates, Save existing files or
templates and Import or Export a report file.

The available menu items are as follows:

Menu Item Functionality
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New This menu item allows you to create a new report.
The report can be create from as a Blank Report, via
the New Report Wizard or from a Saved Template. 

Open Allows the user to select an existing report to open
for editing

Close Closes the currently open report

Save Saves the currently open report, if the report is new
the user will be prompted for a filename and the
location to save the report to

Save As Saves the currently open report with a new filename
and/or file location which the user will be prompted
for

Save As Template Saves the currently open report as a Template, see
the Templates section for more information

Export Exports the currently open report to a location
chosen by the user. The report is stored as an XML
file. This feature is useful if the connection between
the Report Manager and the Server has been lost or
the user wishes to move reports between servers.

Import Imports a report file as an XML file and sends it to the
Server

History Opens the Report History dialog which shows details
of the last 15 saves of the report.

About Displays build and product information about the
Report Manager

Exit Closes the Report Manager dialog

 

Templates are read-only report types. A new template can
be created and saved or a report can be saved as a template.
Create templates for reports that are used frequently. 

 
Use the History menu item to find out when a report was last
saved and details of the user who saved it.

13.2.1 New Menu

From within the New File menu option the user has the choice of creating a new blank file, a
new file via the Wizard or a new file from an existing Template.

Click on any of the icons to create a new file from that source template.
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New File Tab

 

Creating a New Report walks you through the report
creation process.

13.2.1.1 Special Report Types

AQS Reports

The AQS Report type is used to define a set of output channels that are used to generate
standards compliant output for either AQS or AirNow-International systems. The same AQS
Report can be used to generate one or both of the possible AQS and AirNow- International
output types.

The Air Quality System (AQS) is the United States EPA’s repository of ambient air quality data.
Airodis generates version 2.2 of the XML standard for AQS. AirNow-International (AirNow-I) is
a real-time air quality data reporting system. Airodis generates version 3.0 of the AQCSV
standard for AirNow-I.

To create an AQS Report use the File -> New menu option and then select the AQS Report type
as shown in the following screenshot.

http://download.ecotech.com/Airodis%20Media/Media/Report%20Manager%20-%20Creating%20a%20New%20Report/Report%20Manager%20-%20Creating%20a%20New%20Report.html
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AQS Report Type

AQS Report Definition

When the report is run by the Report Scheduler the Date Range is used to determine the
period of time for which values are extracted from the database and output. By default the
previous day’s values are output which is appropriate if you were to schedule the report to
run once per day.
Site Parameters define the site location associated with all the output channels. You can enter
values manually into the edit boxes or use the drop down lists to select predefined values. If
the selected country is code 842 (United States) then the state and county fields have drop
down lists for the selection of well-known values. 

Selection of a different country will not provide any drop down lists for the state or county
and so manual entry of those values becomes necessary.

Checking the IsTribal field will replace the state and county fields with a tribe entry field. Note
that this setting is only appropriate for output to the AQS format because the AirNow-I format
does not support the selection of a tribal code.

Output Channels is a list of the channels for output. To populate this list you can drag channels
from the All Available Channels list and drop them onto the Output Channels list. When
possible the unit and duration values of the dropped channel are automatically populated.
However, this is not always possible and so the user should always double check all settings. 
The purpose of each column is as follows:-

Item Description

Station Station the channel belongs to.

Report Report the channel belongs to.

Channel Channel for output.

Parameter 5 digit code that defines the contents of the channel. You can modify the
5 digit code directly using the number field or by using the second field
which is a description of each code. This field is used for AQS and
AirNow-I output types.
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Unit 3 digit code that defines the unit of measurement. You can modify the 3
digit code directly using the first number field or by using the second
field that is a description of each code. This field is used for AQS and
AirNow-I output types.

AQS Duration 1 character code specifying the duration used for taking the
measurement that is only output for the AQS output type.

ANI Duration Duration in minutes used for taking the measurement that is only output
for the AirNow-I output type.

POC Parameter occurrence code used when the same parameter code is used
on multiple channels. In that case each output channel should have a
unique parameter occurrence code to disambiguate them. This field is
used for AQS and AirNow-I output types.

Method 3 digit code that identifies the method used to perform the
measurement. This field is used for AQS and AirNow-I output types.

AQS Report Tab

AQS Report Scheduling

To generate output for an AQS Report you must create a schedule. Use the Scheduler tab and
then the Add ribbon button to create a new schedule instance. Select the AQS Report by using
the Browse button at the top right of the dialog.

The Schedule tab settings are the same as for scheduling standard reports except the
Destinations tab has a restricted set of options. You can not add a Screen or Serial destination
as they are not compatible with an AQS Report type. 
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The remaining destinations will only provide two Format options, AQS and AirNow-
International.

The AQS format will automatically add XML as the filename extension because AQS type
output is an XML file that conforms to the version 2.2 AQS standard. 
Selecting the AirNow-International format will automatically set the extension to CSV and will
conform to the version 3.0 AQCSV format.

Audit Reports

Airodis tracks all changes made by users to downloaded data. Use an Audit Report to generate
an output listing all such changes to a specified set of stations. This is useful when audit
records need to be printed or archived to satisfy compliance requirements. 
Output can be generated to Microsoft Excel or CSV formats.

To create an Audit Report use the File -> New menu option and then select the Audit Report
type.

Audit Report Definition

The Date Range is used by the Report Scheduler to determine the period of time for which
audit values are extracted from the database and output. By default the previous day’s values
are output which is appropriate if you were to schedule the report to run once per day.

Audit Stations is the list of the stations for output. To populate this list you can drag stations
from the All Available Stations list and drop them onto the Audit Stations list. If you have a
large number of stations defined you can use the Filter By Station field to restrict the displayed
list to just the subset of interest.
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Audit Report

Audit Report Scheduling

To generate output for an Audit Report you must create a schedule. Select the Scheduler tab
and then press the Add ribbon button to create a new schedule. 
Select an existing Audit Report by using the Browse button at the top right of the dialog.

The Schedule tab settings are the same as for scheduling standard reports except the
Destinations tab has a restricted set of options. You can not add a Screen or Serial destination
as they are not compatible with an Audit Report type. 

The remaining destinations only provide two Format options, Microsoft Excel and CSV.

13.2.2 Open Menu

The Open menu allows the user to open an existing report.

Available folders and reports on the Server are shown as a tree view. Clicking on any folder in
the tree will display any reports and child folders that are contained within.
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Open File Dialog

The right click menu of any of the folders in the tree gives the following actions:

Menu Item Functionality

Expand Expands the folder contents to show reports and child folders

Collapse Collapses all child folders within the selected folder

Cut Cut the folder and contents for pasting elsewhere in the tree

Copy Copy the folder and contents for pasting elsewhere in the tree

Paste Paste a previously cut/copied folder into the current folder 

Delete Deletes the folder and contents from the tree

Rename Renames the folder

New Folder Creates a new folder as the child of the currently selected folder

Refresh Refresh the tree view

The right click menu of any of the folders or reports of a folder selected in the tree gives the
following actions:

Menu Item Functionality

Open Opens the folder or report

Cut Cut the folder and contents or report for pasting elsewhere in the
tree

Copy Copy the folder and contents or report for pasting elsewhere in
the tree

Paste Paste a previously cut/copied folder or report into the current
folder 
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Delete Deletes the folder and contents or report from the tree

Rename Renames the folder or report

Batch Reschedule Opens the Batch Reschedule dialog

New Folder Creates a new folder as a sibling folder at the current level

Refresh Refresh the tree view

Recently Used Reports

When a report is opened it is added to the Recently Used Reports list. Right clicking on a report
in the list allows the user to perform the following actions:

Menu Item Functionality

Open Opens the report

Delete Deletes the report from the list

Pin Adds the report to the Pinned Reports list

 

Pinned Reports

When a report is added to the Pinned Reports list the following functions are available via the
right click menu:

Menu Item Functionality

Open Opens the report

Delete Deletes the report from the list

Unpin Removes the report to the Pinned Reports list

Missing Channels

If a Station has been deleted from the database and then added again the Station ID will have
changed. When opening a Report associated with that Station the following message dialog
may be seen: 
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Missing Channel Details Dialog

If the user knows that the Station exists but has a different ID then they may choose to
continue loading the file and can then renumber the Station as detailed here.
This dialog is likely to be seen when using Templates across different workspaces.

13.3 Stations Tab

The Stations tab allows the user to select the Stations, Reports and Channels that are used in
the current report.

All Available Stations

Stations that have been added to the Client are shown in this list. Each station can be
expanded to show its available reports and within the reports the available channels.
The user may select a Station, Report or Channel from the list and drag it across to the Report
Stations list for use in the current report.

Multiple Stations, Reports or Channels can be selected from this list by holding down the
<CTRL> key on the keyboard while making the selection with the mouse.
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In addition to dragging the selected items across to the Report Stations list the user may also
use the right click Add menu item or the Add button on the ribbon at the top of the dialog. 

Report Stations

The list of Stations, Reports and Channels used in the current report is shown here. This list
will be empty in a new report and populated in an existing report.

The user may select a Station, Report or Channel from the list and remove it by using the right
click menu item Remove, additionally the ribbon item Remove may also be used.

Multiple Stations, Reports or Channels can be selected from this list by holding down the
<CTRL> key on the keyboard while making the selection with the mouse. In this way multiple
items may also be removed from the list.

The ribbon menu item Remove All will clear the Report Stations list.

An additional right click menu item is available, see the Renumber Station section for further
details.

Filter By Station

The All Available Stations list may be filtered using this control. Simply type part of the station
name into the text box and the list will automatically be filtered to only show station names
containing that text.

 Note that Virtual Stations in the Client are not selectable in
the Report Manager and will not be shown in the list of
available stations. As Virtual Stations are created from

existing physical stations these physical stations should be used in
Reports instead.

13.3.1 Renumber Station

The Renumber Station functionality is used to renumber a station in a report where the station
ID in the Client may have changed. This may be due to the station being removed and re-added
to the Station List.
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The Report Manager, on opening an existing report, checks
that all of the Stations, Reports and Channels used by the
report are available. Should it find that any of these

elements do not exist in the system then a warning will be given to
the user and they will have the option of continuing to load the
report or not.

The Renumber Station function also enables the user to move a report from one Server to
another and renumber the station if it doesn't have the same ID in both systems.

Renumber Station Menu

Use the right mouse click to access the Station menu and select Renumber.



107Report Manager

© Acoem and related entities 2023

Renumber Station Dialog

13.4 Edit Tab

13.4.1 Overview

The Edit tab contains a ribbon control that enables the user to add, align and resize report
objects as well as format text based objects. 
Additionally the user may Preview a report from this tab and add or remove pages from the
report.

The components of the Edit tab are as follows:

Number Functionality

1 - Generate Generate the report at the current date or a specified date to
preview or save the output. Additionally refresh the previews of
the Graph and Table objects in the report  
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2 - Clipboard Cut, Copy and Paste report objects

3 - Appearance Set font styles and colouring for report Text objects

4 - Alignment Use these controls to align report objects

5 - Spacing Use these controls to space report objects

6 - Sizing Use these controls to size report objects and show/hide the
layout grid

7 - Objects Select the report object to be created from this panel

8 - Page Navigate through, Add and Remove pages from the report here

9 - Blank Report Page This is the first page of a new report

10 - Property Editing Tab When selecting a Report, Object or Block  its properties can be
changed here. Most of the properties here can also be changed
via the ribbon controls.

11 - Zoom Slider Use the slider to zoom in or out on a page or report 

13.4.2 Report Properties

The Report tab contains properties that affect objects report-wide. These properties apply to
every page, block and object (unless explicitly overridden).
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Appearance
Page Background The background colour of each page. It is opaque white by default, but can be

set to another colour or transparent. A transparent background can be useful
when producing PNG output for web.

Data Period
For more information on how data periods are calculated, see How Report Data Periods Work.

End This is the end time of the report. By default, it is the current time. It can be
set to a set time of the day, or the start of the current minute, hour, day,
month or year.

End Offset This will offset the end date by a fixed amount of time. For example, you can
make a report end at the end of the current hour by setting the end date to
"Start of Hour" with a one hour end offset.

Start This is the start date of the data period. Setting this to "Set Duration" will
allow you to make the report run for a fixed period that is anchored to the end
time. Setting this to the previous hour, day, month or year will also have the
report run over a fixed duration anchored to the end time. This can also be



110 Airodis Manual

© Acoem and related entities 2023

fixed to the start of the minute, hour, day, month or year. Doing this may
make the duration of the report vary from one run to the next.

Time Zone This is the time zone that the data period operates in. When running "Preview
Now" or running a scheduled report, the time zone property is used to
determine what "now" means.

Time Zone
Conversion

If a station's raw data is stored in a different time zone to the report's
specified time zone, this will convert the data into the report's specified time
zone when generating the report. This option is useful of a station is logging
in UTC and the report output needs to be in local time. This can also correct
for stations that do not offset their hardware clocks for daylight savings.

Layout
The layout properties are linked to the Page Setup controls on the Layout tab. These settings
are measured in pixels, and affect every page in the report.

Footer Height Height of the footer block.

Header Height Height of the header block.

Margin Bottom The margin between footer block and the bottom edge of the page.

Margin Left The margin on the left of the page.

Margin Right The margin on the right of the page.

Margin Top The margin between header block and the top edge of the page.

Page Height The total height of the page including all margins, headers, and footers.

Page Orientation Portrait or landscape. Toggling this property swaps the page height and page
width.

Page Width The total width of the page including all margins, headers, and footers.

Security
These settings determine execution privileges for reports that are run from the Web Module.

Allow Custom Date Ranges
Selecting this option allows the web module to accept date range parameters embedded in a
permalink. When disabled, unauthenticated reports requested by permalink can only be run
over the default date range. This is useful to ensure that the general public cannot abuse a
report to request large amounts of historical data.

IP Access Range
The IP Access range determines the IP ranges from which a web module user may run a report
without any authentication. This defaults to "None" to ensure that reports are only publically
accessible via the Web Module when explicitly permitted.

While it's possible to create any comma delimited list of IPv4 or IPv6 addresses (or CIDR
blocks), there are some presets for common CIDR classes:

Preset Value Description

None n/a Only logged-in users with permissions
to run the report are able to view it.
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Localhost [::1], 127.0.0.1 Unauthenticated users on the same
machine can view the report.

LAN [::1], [fe80::]/10, [fc00::]/7, 127.0.0.1,
169.254.0.0/16, 10.0.0.0/8,
172.16.0.0/12, 192.168.0.0/16

Unauthenticated users within a
private network can view the report.

Internet [::]/0, 0.0.0.0/0 Everyone can view the report.

13.4.3 Generate

The Generate menu item allows the user to preview the report in two ways:

Menu Item Functionality

Preview Now The report is run and a preview is created using the current system date
and time

Custom The report is run using the date and time specified by the user and
optionally generated in a format other than a screen preview

Refresh Previews All of the images for the Graph and Table objects in the report are
refreshed

Generate Report

Generate Report Dialog

The Generate Report dialog allows the user to preview the report on screen at either a fixed
end date or fixed start and end dates.
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Optionally an output format can be specified and the report will be generated in that format
for the specified dates and times. 
The user will be asked to specify a destination for the report output and the report will be
saved to that destination.

Selecting the Append Timestamp tick box will append the current date and time to the report
so that multiple reports of the same type can be 
saved to the same destination.

Use the Generate Report functionality to generate 'one-off'
report outputs instead of scheduling a report for a single run.

 

13.4.4 Report Objects

Report Objects are the components that make up a report.

In Airodis the following objects are available:

Graphs

Tables

Pictures

Shapes

Text

To create a new Report Object click on the object menu item in the Edit tab. For objects
requiring multiple parameters and settings, e.g. Table or Graph, a dialog specific to that object
will be displayed. For other objects the, e.g. Text, the mouse cursor will change to allow the
user to specify where on the page the object must be created. 

Selecting, Moving and Editing Objects
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Selected Object

When selected an object will display a thick border.
The object can now be moved around the page using
the mouse pointer.

Multiple Selected Objects

 
Multiple objects can be selected by holding down the
<CTRL> key while selecting with the mouse or by
dragging the mouse cursor to encompass multiple
objects.

Selected Object - Ready for editing

In order to edit the contents of a Text box just
double click on the object, this will allow the text
in the box to be changed. More complex objects
like Graphs and Tables will display a dialog
allowing the user to change their settings.

Objects can not be dragged across Header, Footer or Page
boundaries. In order to move an object across one of these
boundaries the user must Cut or Copy and Paste the object

into its new position.

13.4.4.1 Graphs

A graph is used to depict a relationship between two or more variables. The simplest and most
common usage of graphs is to show channel data over a period of time, such as displaying a
temperature reading over the span of a week. Linear graphs are used for this purpose. 

Frequency Distribution graphs can be created that show how often a value has occurred. This
will split the horizontal axis into a set of ranges and then use the vertical axis to show how
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often that range occurred during the time interval. For a temperature channel this would
allow us to quickly see what percentage of time the temperature was above a critical
threshold.

Polar charts are the final option and are used to display vector information. Vector data has
both a direction and a magnitude which are combined for display on a polar chart. A common
example would be combining separate wind direction and wind magnitude channels.

The graph settings are divided into several different tabs and many of the tabs operate in the
same way no matter which graph type is selected. 

Graph Work Flow Example

When adding a new Graph to a report the process will be as follows:

1. Click on the Graph menu item on the Report Manager Edit tab
2. Select graph type: Linear, Distribution or Polar
3. Change settings on the Properties tab as required. 
4. Select the channels you want to graph from the available channels on the Data Set tab.
5. On the same tab select each chosen channel in turn and set their properties.
6. Add level markers if required on the Level Markers tab.
7. Add axes and change axes settings on the Axes tab.
8. Preview the graph output in the Preview tab.
9. Make any changes to the graph settings and select OK.
10. Click on the report page to position the Graph object 

Graph Objects gives an overview of this object type.

13.4.4.1.1  Properties Tab

The Properties tab changes when different types of graphs are selected. Most of the controls
on this tab are common but some are specific to certain graph types.

http://download.ecotech.com/Airodis%20Media/Media/Report%20Manager%20-%20Graph%20Objects/Report%20Manager%20-%20Graph%20Objects.html
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Properties Tab

The graph types are divided into the following categories:

· Linear
o Diurnal

· Distribution
o Frequency
o Cumulative

· Polar
o Concentration
o Dose
o Scatter
o Wind Rose

13.4.4.1.1.1  Linear Graphs

This is the default graph type and has the following set of simple properties:

Properties Tab

Item Description

Graph Title Main title that will appear in a large font at the top of the output.

Subtitle Use the Manual setting to enter your own text for display. The
default option of Automatic will create a subtitle that describes the
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time period that the graph is outputting. The subtitle is output
underneath the main title and in a smaller font.

Minimum Data % Each data point used for the graph will need to have this percentage
of channel values before it is considered valid and used. 

For example, consider a channel that has 1 minute data and we are
displaying it as a 10 minute average. This means the graph will output
a data point once per 10 minutes based on the average of the 10
records for that period of time. If the Minimum Data is defined as
100% then all 10 records must be present for a 10 minute period
before it is output. A setting of 50% would require there be 5 or more
1 minute records present before a 10 minute average is calculated
and output.

Date Range By default the date range is inherited from the report. Use the custom
settings to override this behaviour and setup graph specific settings.

X-Axis Defaults to showing the date and time on the x-axis. To compare
channels against each other you can use this option to select the
channel that represents the horizontal axis. Note that this setting is
ignored if the Diurnal Slice setting is used.

Legend Position Dictates where the graph legend will be positioned in relation to the
graph. Options are: Top, Left, Right, Bottom.

Font Size Font size affects the size of the legend, graph title, x and y axis
legends. It is restricted to between 50 and 150% of the default font
size. 

Grid Colour Changes the colour of the grid lines.

Grid Opacity Changes the opacity of the grid lines. By default the major and minor
grid lines have a different opacity and minor grid lines can be turned
off by deselecting the Minor Grid Lines tick box. 

Diurnal Slice Splits the source data into periodic ranges that allows easy
comparison. 

For example, set the slice to be day on day and then select a date
range of 1 month. Add the same temperate channel twice to the Data
Sets tab for display. For the first data set we define that only the
week days should be included and for the second data set we define
only the weekend days. 

Now the graph will show an x-axis that represents 1 day with two
lines shown. The first line showing the average weekday
temperatures and the second the average weekend temperatures.
Any unexpected discrepancy can then easily be seen.
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Linear Graph Definition

An example of a linear graph that makes use of multiple data sets, level markers and an axes
definition follows. 
The level markers are used to indicate ranges of values of special interest. In this example the
range from 0 to 20 is labeled OK, the range from 20 to 35 as Warning and anything above 35 as
Danger! 
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Linear Graph Example

Linear Graph examples can be found in this file: Linear
Graph Example

13.4.4.1.1.2  Distribution Graphs

Some of the graph properties are the same across all the graph types. 
These common properties maintain the same meaning across all the graphs to prevent
confusion.

Properties Tab

Item Description

Graph Title Main title that will appear in a large font at the top of the output.

Subtitle Use the Manual setting to enter your own text for display. The default
option of Automatic will create a subtitle that describes the time
period that the graph is outputting. The subtitle is output underneath
the main title and in a smaller font.

Minimum Data % Each data point used for the graph will need to have this percentage
of channel values before it is considered valid and used. 
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For example, consider a channel that has 1 minute data and we are
displaying it as a 10 minute average. This means the graph will output
a data point once per 10 minutes based on the average of the 10
records for that period of time. If the Minimum Data is defined as
100% then all 10 records must be present for a 10 minute period
before it is output. A setting of 50% would require there be 5 or more
1 minute records present before a 10 minute average is calculated
and output.

Date Range By default the date range is inherited from the report. Use the custom
settings to override this behaviour and setup graph specific settings.

Legend Position Dictates where the graph legend will be positioned in relation to the
graph. Options are: Top, Left, Right, Bottom.

Font Size Font size affects the size of the legend, graph title, x and y axis
legends. It is restricted to between 50 and 150% of the default font
size. 

Grid Colour Changes the colour of the grid lines.

Grid Opacity Changes the opacity of the grid lines. By default the major and minor
grid lines have a different opacity and minor grid lines can be turned
off by deselecting the Minor Grid Lines tick box. 

Graph Type A setting of Frequency will calculate how often values occurred for
each range and then use that percentage as the output. So if a
temperature channel has an interval of 5 degrees then each graph
output will be the percentage of channel values were within that
particular 5 degree range.

Changing this setting to Cumulative will output the percentage for
the current range added to the percentage for the previous range.
This therefore accumulates values across the graph until the last
range which must have a value of 100% as it represents all the ranges
added together.

Data Range Set a minimum and maximum data values that define the range of
values that will be used for output on the x-axis. These values must
be provided by the user because they cannot be automatically
calculated. This range combined with the Intervals setting is used to
specify the range of each individual interval.

Intervals Number of intervals that the data range should be split into. There
will be one graph output value per interval. 

Scale Used to switch between the default of linear and logarithmic.
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Distribution Graph Definition



121Report Manager

© Acoem and related entities 2023

Distribution Graph Example

Distribution Graph examples can be found in this file:
Distribution Graph Example

13.4.4.1.1.3  Polar Graphs

All Polar graphs are used to map information related to wind direction and speed. There are
four types of Polar graph.

Polar Concentration
A concentration polar plot displays the average value of a channel’s data relative to a specific
wind direction and wind speed. You should use the Wind Direction and Wind Speed setting on
the Properties tab to specify the relative channels used in the calculation. Wind direction is
shown by the direction the graphical blocks are facing on the compass. Wind speed is
designated by the size of the graphical block.

Polar Dose
A dose polar plot displays the frequency distribution of a channel’s data relative to a specific
wind direction and wind speed. This polar plot is designed to show the percentage of data
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points that were recorded from different directions at different wind speeds. The magnitude
of data is not assessed. 
You should use the Wind Direction and Wind Speed setting on the Properties tab to specify the
relative channels used in the calculation. Wind direction is shown by the direction the
graphical blocks are facing on the compass. Wind speed is designated by the size of the
graphical block.

Polar Scatter
A scattered polar plot displays the distribution of channel data relative to a wind direction and
wind speed. You should use the Wind Direction and Wind Speed setting on the Properties tab to
specify the relative channels used in the calculation. Wind direction is shown by the direction
the graphical blocks are facing on the compass. Wind speed is designated by the size of the
graphical block.

Polar Wind Rose
A wind rose displays the distribution of wind speed relative to wind direction. You should use
the Wind Direction setting on the Properties tab to specify the relative channel used in the
calculation. Wind direction is shown by the direction the graphical blocks are facing on the
compass. Wind speed is designated by the size of the graphical block.

Properties Tab

Item Description

Graph Title Main title that will appear in a large font at the top of the output.

Subtitle Use the Manual setting to enter your own text for display. The
default option of Automatic will create a subtitle that describes the
time period that the graph is outputting. The subtitle is output
underneath the main title and in a smaller font.

Minimum Data % Each data point used for the graph will need to have this percentage
of channel values before it is considered valid and used. 

For example, consider a channel that has 1 minute data and we are
displaying it as a 10 minute average. This means the graph will output
a data point once per 10 minutes based on the average of the 10
records for that period of time. If the Minimum Data is defined as
100% then all 10 records must be present for a 10 minute period
before it is output. A setting of 50% would require there be 5 or more
1 minute records present before a 10 minute average is calculated
and output.

Date Range By default the date range is inherited from the report. Use the custom
settings to override this behaviour and setup graph specific settings.

Legend Position Dictates where the graph legend will be positioned in relation to the
graph. Options are: Top, Left, Right, Bottom.
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Font Size Font size affects the size of the legend, graph title, x and y axis
legends. It is restricted to between 50 and 150% of the default font
size. 

Grid Colour Changes the colour of the grid lines.

Grid Opacity Changes the opacity of the grid lines. By default the major and minor
grid lines have a different opacity and minor grid lines can be turned
off by deselecting the Minor Grid Lines tick box. 

Graph Type Determines the type of polar graph to create. Options are:
Concentration, Dose, Scatter and Wind Rose.

Wind Direction Specifies the channel to use for wind direction.

Wind Speed Specifies the channel to use for wind speed.

Compass Points Splits the circle into this number of intervals where one output value
is calculated per interval. Note that the Compass Points setting is for
the number of data compass points and not the number of legend
compass points.

Polar Graph Definition
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Polar Dose Graph Example

Polar Graph examples can be found in this file: Polar Graph
Example

13.4.4.1.1.4  Radar Graphs

Radar graphs are used for graphing data from radar-type instruments. At present, the only
supported instrument is the Leosphere WindCube (Lidar).

Properties Tab

Item Description

Azimuth (Required) The channel to use to determine the azimuth angle of a
reading

Step (Required) The resolution of the azimuthal axis.  The output graph
will round all data points to the resolution defined here. This needs
to be set to at least the resolution the instrument is logging in.
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Elevation (Optional) The elevation channel. If this is omitted, all data points
will be assumed to be flat (zero elevation). The elevation is used to
correct  the distance from source for altitude when creating a top-
down projection. This is required to accurately draw a radar graph
atop a map image.

Intensity (Required) The channel to use to determine the intensity of a
reading. This can be a beta reading, wind speed etc.

Mass Conversion Correlate the intensity to mass readings accumulated from
instruments within range of the radar/lidar; output the intensity
readings on a mass scale.

Noise Filter (Optional) If the instrument has a signal/carrier-to-noise  channel, a
threshold can be set to remove noisy data. Select the channel here.

Min Threshold If a noise filter channel is set, this is the noise threshold value. Any
data with a signal value below this threshold will be removed from
the graph output.

Scan ID (Optional) This is used for inclusive data filtering. Typically, this will
point to a channel which uniquely identifies a scan scenario to filter.

Scan ID Filter If the Scan ID has been specified, enter the filter value here. Only
data where the filter scan ID channel matches this value will be
included in the output.

Colour Scale The colour scale to use for output. This can be a Doppler scale
(blue=towards; red=away), an Inverse Doppler scale (red=towards;
blue=away), a heat (rainbow) scale or a gray (black to white) scale.

If level markers have been defined, it is possible to use the level
marker colours for colour coding.  This can be useful if a specific
colour range is required without a gradient.

Opacity The opacity of the radar data. This is completely independent of the
grid opacity. Lower the opacity if you need to draw a radar above a
map.

Calculation A single point on a radar graph can consist of points from multiple
timestamps and elevations. This field sets the calculation used to
handle multiple values. Options include taking the latest reading or
an average of all readings (among others).

Data Output Used only in the output of Mass data, select between LiDAR (default)
and Correlation values.
For correlation values the output will display the current correlation
value in use and properties for each associated Mass Channel. This
property is used as a flag in the scheduling of report output, so that
the report contains either of the two data types.
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Radar Graph Definition
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Radar Graph Example

Mass Conversion
Using BAM readings from multiple points in the field, Airodis can combine this with past Lidar
readings to calculate a correlation between Lidar (Beta) readings and BAM (Mass) readings.
Airodis can then display a radar graph scaled to projected mass values (e.g. ppm or µg/m³)
instead of raw beta values.

Populate the mass channels with all of the BAMs within range of the Lidar. Ensure that all
stations are logging the same matter on the same scale (e.g. dust PM10 in µg/m³). It is also
imperative that the Lidar and all BAM stations have their coordinates (at least Longitude and
Latitude) entered in the station settings. Elevation is optional (assumed zero unless entered
otherwise), but is recommended for accuracy. The Field Position column can be used to verify
the distance and direction to each station from the lidar.
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Item Description

Calculation This should be set to the average of the period to use for calculating
the correlation. Most BAMs log in one hour intervals, so it will
correlate against at least the previous one hour of lidar data. This
period can be set longer, but note that long correlation periods can
significantly increase rendering times.

Label If the automatic label is undesirable, a manual label can be entered.

Point Labels When enabled, the BAM will be displayed on the radar graph with a
dot, a label (if entered) and the latest reading. If disabled, the BAM
reading will be used to calculate the correlation factor, but the station
will not be displayed on the radar graph.

Note: The values of Type, Style and Colour are not used in Radar graphs.

13.4.4.1.2  Data Set Tab

This tab is used to construct a list of channels that are displayed in the output graph. 
On the right hand side is the set of all available channels that can be chosen from. Station
channels that have been setup in the applications Stations tab are listed first followed by the
collection of Calculated Channels defined for this report. 
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Drag Channels into Data Set

Use the mouse to drag  a channel and drop it onto the left area of the tab, this will add a new
entry. 
Remove existing entries by selecting the entry and then using the delete key. 

Selecting a channel will make further options available for that channel.

Each data set entry has the following columns:

Item Description

Channel Description of the channel.

Calculation Function used to calculate the output. If the selected function
requires an additional parameter, such as Nth Minimum, it will
automatically present an additional input box below the function
name.

If the rolling period needs to differ from the Display Interval column
value set the rolling check box. This will then present an additional
control so that the period can be defined.

Display Interval Specifies the interval over which each output covers. If you select 1
hour then the graph will have one data point per hour that is
calculated using the function defined in the Calculation column.
When no value is specified it will use whatever values are available
for the channel.

Display Unit If you specify a display unit that is different from the units defined in
the Client application then an automatic conversion will occur
between the two units. For example, if you channel records
centigrade but you select kelvin in this field then it will automatically
convert all values from centigrade to kelvin values.

Label The label to be displayed for this channel. By default the automatic
option is selected and the automatically generated label shown. This
can be changed to a manual label definition if required. 

Plot Determines how the data series is drawn for linear and distribution
type graphs. Different options include Area, Bar, Line, Spline, Point
and Step.
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Style The style to be applied to the plot, available options will differ
depending on the Plot Type selected.

Colour Click the coloured block in order to show a dialog that allows the
colour to be modified. By default the colours of different series are
likely to be different but occasionally clashes can occur.

Data Set Tab

13.4.4.1.3  Level Markers Tab

A graph can be annotated to show Lines or Blocks with labels. Use a line marker to indicate a
significant value such as an error level on the graph. 
This makes it easy to spot values that move above or below that significant value. 

A range of values can be used to mark an entire block that is then drawn with a background in
the specified colour, useful when there is an upper and lower limit that needs indicating.

Item Description

Label Text to use on the graph for labelling the level.

Value A single edit box is used for a Display Type of Line and is the value at
which a line is drawn on the graph. Two edit boxes are used for a
Display Type of Block and define the band that will be coloured.

Unit Determines the units that the value represent.

Colour Colour used to draw the line or band.

Display Type Specifies if a line or block should be drawn.
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Level Markers Tab

13.4.4.1.4  Axes Tab

Use the Axes tab when you need to customize the display or axis details. By default the graph
will automatically create a different axis for each unique unit and automatically define the
range of values shown on each axis. 

For example, if you have defined two data sets that are temperature channels and the first has
a unit of Centigrade and the second is Kelvin then the output graph will have two axes shown,
one for each of the units.

To modify the default behaviour you need to add an axis entry that has the same unit name as
the one that would be produced automatically. Then the graph will use the settings from the
entry you have defined. 
In this example two entries would be added, the first specifying centigrade and the second
kelvin. Then the minimum and maximum range values would be used from those specified
instead of being automatically calculated.
 
Add new entries by using the appropriately marked button at the lower left of the tab. 
Remove an entry by first selecting it and then pressing the delete key.

Item Description

Unit Unit of the axis to be customized.
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Min Lower limit of the axis range. Values below this limit will not be output on
the graph.

Max Upper limit of the axis range. Values above this limit will not be output on
the graph.

Visible Checked to hide the axis from being shown. The data values will still be
drawn but the axis that describes the values will not. This is useful when
the graph would normally display multiple axes and you would like to
remove all but one from being shown.

Align axes at zero Find this setting on the lower right corner of the page. Checked to ensure
that the zero position of each axis is positioned at the same vertical
position. This alignment makes it much easy to relate different data sets.

Axes Tab

13.4.4.1.5  Preview  Tab

Make use of the Preview tab to test the configuration settings. Each time you navigate to the
Preview tab a new image will be generated using the current settings. 

If the output is not as intended then move back to a different tab, make adjustments, and
then use preview again.
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Preview Tab

13.4.4.2 Tables

Table

A table is a means of arranging data in rows and columns. Each row represents a time period
and each column a data source. Data sources are either station channels or report defined
calculated channels. Consider using a table when you need to view, compare or export precise
values.

A wide range of settings allows all aspects of table generation to be customized. All settings
have default values allowing a table to be created with a minimum of setup. Data values can
be custom formatted, such as rounding to the required number of decimal places. Times and
dates can be customized, such as showing the full month name. The visual appearance of cells
can be modified by using the appropriate colour, font and alignment options.

Table Work Flow Example

When adding a new Table to a report the process will be as follows:

1. Click on the Table menu item on the Report Manager Edit tab
2. In the Columns tab add the Channels that will appear in the Table. Expand the Row

Descriptions and Station objects in the Channels frame and drag selected items across to
the Display Columns frame. 
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3. For each channel item in the Display Channels frame, select the channel and apply changes
to its Data, Appearance and Conversions properties via the appropriate tab. 

4. Select the Footers tab and select any footer items needed in the table by dragging a
selected item from the Predefined frame to the Rows frame.

5. For each footer item in the Rows frame, select the item and make changes to its Data and
Appearance properties via the appropriate tab.

6. Select the Headers tab and make any changes required to the formatting of the Column
Headers and Footer Row Headers.

7. Select the Table tab and make any changes to the overall table definition as required.
8. Preview the table output in the Preview tab.
9. Make any changes to the table settings and select OK.
10. Click on the report page to position the Table object 

Table Objects gives an overview of this object.

Unlike other report objects the table height will
automatically expand to show all the output rows when the
report is generated.

http://download.ecotech.com/Airodis%20Media/Media/Report%20Manager%20-%20Table%20Objects/Report%20Manager%20-%20Table%20Objects.html
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13.4.4.2.1  Table Tab

The Table Tab

Table Settings

The most common table settings are contained in this section.

Item Description

Description Used when a table is exported to Microsoft Excel and becomes the
name of the Microsoft Excel Sheet that contains the table output. 
This makes it easy to find the table in an exported Microsoft Excel
document.

Display Interval The time interval that each row represents. Selecting 5 minutes will
generate a row per 5 minute block of time. If the reporting period is 1
hour then this would result in 12 rows of 5 minutes each.

It also adjusts the alignment of the reporting period. So selecting 5
minutes will adjust the end date of the report to be a multiple of 5
minutes. Your report would not finish at 3 minutes past an hour but
instead be adjust backward to finish exactly on the hour.
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Date Range By default the date range is inherited from the report. Use the custom
settings to override this behaviour and setup table specific settings.

Max Data Rows Defines the maximum number of data rows to create when
generating a preview. This setting is ignored when generating a full
report.

Data Row Height The pixel height of each data row. If you select a large font then you
will need to increase this height so that text will fit into the output
cells.

Border Width The pixel width of the border around every table cell. Select a value
of 0 (zero) to remove borders from around cells.

Border Colour Used to define the colour of the border around each table cell.

Default Appearance

Cell appearance can be customized in several different sections of the table dialog. When a
setting is not customized in another part of the dialog it will default to values defined here. 
For example, altering the font size to 16 in this area will cause all cells to be output at size 16.
If you then use the Headers tab to alter the Column Header Appearance font size to 18 then all
the cells in the table will be size 16 except for column headers that would be sized 18.

Item Description

Column Width Defines the pixel width of the column.

Cell Colour Background colour of cells in the first, third, fifth row and so forth.  

Alternate Colour Background colour of cells in the second, fourth, sixth row and so
forth.

Text Colour Colour of cell text.

Font Family Font used for cell text.

Font Size Size of the font used for cell text.

Font Style Optionally draws the font in bold, italic and underlined.

Alignment Positions the text to the left, centre or right of the cell.

Advanced Settings

The advanced settings have a major impact on how the table is generated. They can be used to
hide rows that should normally be output. Time slicing is an advanced feature that splits each
data column into multiple output columns.

Item Description

Show Headers Determines if the column headers row is output

Show Data Rows Determines if the data rows are output, does not alter the output
of column headers or footer rows.
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Show Empty Data Rows Determines if rows that have no associated data should be
output or just ignored.

Show Time Slices Determines if each data column should be sliced into multiple
columns each of which covers a fraction of the data row period.

Snap 'Current' Date Range When this option is selected it will 'snap' the time periods in the
table rows to the nearest time interval as determined by the
Display Interval. For example a Table with a Display Interval of 1
hour is run at 25 minutes past the hour. Without this option set
the table rows will have times of e.g. 14:25, 15:25, 16:25 etc. With
this option set the time is 'snapped' to the nearest hour so the
table row times would be 14:00, 15:00, 16:00 etc.

13.4.4.2.1.1  Table Time Slicing

By default a single display channel will result in a single output column. Time slicing splits the
output column into multiple output columns based on a provided time slice interval. This is
best explained by using an example. 

Imagine a table that has a Display Interval of 5 minutes and two display columns, the first
showing the time for the row and the second a temperature that has 1 minute data available.
The report is run over a period of 30 minutes and produces the following output. 

Time Slicing Example 1

Each row contains a 5 minute average with the footer providing an average over the entire 30
minute reporting period. The Count displayed in the footer confirms that 30 records were
used in the report because the temperature has 1 minute data. 
To enable time slicing you select the check-box labeled Show Time Slices on the Table tab. This
will add a new Time Slice Interval setting to the Table Settings section. 
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Table Time Slicing Definition

The Time Slice Interval must divide exactly into the Display Interval so that each generated
column covers the same period of time and when combined covers exactly the period of the
row. In our example we will use a time slice of 1 minute. Now when the table is generated we
get the following more complicated output.

Time Slicing Example 2

Our temperature column has been split into five output columns because the time slice
interval of 1 minute divides into the display interval 5 times. On the right hand side of each
row there is aggregate information for the column. We can confirm the data is correct because
the per-row average is the same as shown in the original table before time slicing was used.

Additional aggregate information is shown at the end of the table for each of the time sliced
columns. This provides a way to find the average, or other averaging function, over a slice of
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time. In the above example the first column provides the average for temperatures at each 5
minute interval.

See an example of time slicing in this file: Time Slice Table
Example

13.4.4.2.2  Headers Tab

Column Header Appearance

Use these settings to modify the appearance of column headers. To the right of each setting is
a red button that is used to default the setting. When defaulted, the value to use is retrieved
from the Default Appearance section of the Table tab. 

Item Description

Cell Colour Background colour of cells in the first, third, fifth row and so forth.  

Alternate Colour Background colour of cells in the second, fourth, sixth row and so
forth.

Text Colour Colour of cell text.

Font Family Font used for cell text.
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Font Size Size of the font used for cell text.

Font Style Optionally draws the font in bold, italic and underlined.

Alignment Positions the text to the left, centre or right of the cell.

Row Header Appearance

Row headers are just when footers are defined. Use these settings to modify their
appearance. To the right of each setting is a red button that is used to default the setting.
When defaulted, the value to use is retrieved from the Default Appearance section of the
Table tab. 
The Column Width is only used when an extra column needs to be created for showing the row
headers. This is only necessary if there is no row description column defined, as row
description columns are used for displaying row headers within the footers area.

Item Description

Column Width Defines the pixel width of the column.

Cell Colour Background colour of cells in the first, third, fifth row and so forth.  

Alternate Colour Background colour of cells in the second, fourth, sixth row and so
forth.

Text Colour Colour of cell text.

Font Family Font used for cell text.

Font Size Size of the font used for cell text.

Font Style Optionally draws the font in bold, italic and underlined.

Alignment Positions the text to the left, centre or right of the cell.



141Report Manager

© Acoem and related entities 2023

13.4.4.2.3  Columns Tab

Display Columns Tab

The Display Columns tab shows a list of the output columns. To add a new entry you use the
mouse to drag an item from the Channels tab and drop it onto the display columns list. A new
entry will then be created and appended to the end of the current entries.

On the same line as the Display Columns tab are three small buttons. These show an up arrow,
down arrow and red cross and become enabled once you select a display column entry. The up
and down arrows are used to move the selected item up and down the list of entries. This
alters the order in which the columns will be output in the table. To ensure a column is output
as the first table column it should be moved upwards to become the first entry in the list.  Use
the button with a red cross to delete the currently selected entry.

Channels Tab

This tab contains items that can be dragged into the display columns area in order to define
the output columns. Available items include:-

Row Descriptions
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Use the Row Count to output the row number starting at 1 and incrementing by one for
each output row. This is useful in checking that the table is outputting as many rows as
expected. 
Following are a set of predefined time and date formats, such as General Date, for
showing the time and date associated with each row. If none of the predefined formats is
appropriate you can use the Custom Format entry instead, this allows you to enter a
custom formatting specification.

Stations

Each station associated with the report will appear as a single entry. You can expand the
station to show the reports and expand reports to see available channels. Only channels
can be dragged over to the display columns area for output as columns.

Calculated Channels

Each calculated channel for the report will be listed.

13.4.4.2.3.1  Data Tab

When a display column is selected this tab is shown and allows settings related to generating
the cell data to be modified. 
The setting displayed depends on the type of column selected.

Row Description Settings

Item Description

Header Text used in the column header.

Row Description Specifies if the column is outputting a row number or a date. 

Date Format Determines how the date is converted into text. Predefined settings
such as General Date and Short Time can be used for common
requirements. If none of the predefined settings are appropriate
then use the Custom Format option in combination with the
following field.

Custom Format When the Date Format is set to Custom Format this setting is used to
define how a date is converted to text.
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Station Channel and Calculated Channel Settings

Item Description

Header Text used in the column header.

Rolling Period Time interval over which the rolling function operates. If an empty
value is specified then it defaults to using the Display Interval from
the Table tab.

Rolling Function Function used to calculate the cell value.

Rolling Parameter This field only appears if you select a Rolling Function that requires an
additional parameter. For example, selecting a function of Nth
Maximum will show a rolling parameter labeled Nth.

Valid Threshold Percentage of values that must be valid in order for an output to be
generated. If the percentage is not met then the output cell is left
blank.

Minimum Value Values must be greater than or equal to this setting to be valid.

Maximum Value Values must be less than or equal to this setting to be valid.

Numeric Format Determines how the output value is converted into text. Predefined
settings such as General Number and Percentage can be used for
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common requirements. If none of the predefined settings are
appropriate then use the Custom Format option in combination with
the following field.

Custom Format When the Numeric Format is set to Custom Format this setting is used
to define how a value is converted to text. You can specify the
number of decimal places, user of thousands separators and alternate
formats for positive, negative and zero values.

Output Status Value When selected the Status Value will be output in place of the data
value for this Channel. See here for Status Codes.

13.4.4.2.3.2  Appearance Tab

Use the settings in this tab to modify the appearance of column specific cells. By default all of
these settings are defaulted and so the settings are retrieved from the Default Appearance
section of the Table tab. 
When you change any of the settings it will only be applied to the selected display column.
For example, if you have two display columns defined and you modify the Text Colour of the
first to be blue the generated table will only have blue text in the first column. The second
column will not be affected by the change.
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If you modify a setting and need to set it back to the defaulted state you can use the red
button to the right of each property.

Item Description

Column Width Defines the pixel width of the column.

Cell Colour Background colour of cells in the first, third, fifth row and so forth.  

Alternate Colour Background colour of cells in the second, fourth, sixth row and so
forth.

Text Colour Colour of cell text.

Font Family Font used for cell text.

Font Size Size of the font used for cell text.

Font Style Optionally draws the font in bold, italic and underlined.

Alignment Positions the text to the left, centre or right of the cell.

13.4.4.2.3.3  Conversions Tab

Cell values for a data column can be converted before they are output. This allows the output
text to be modified as well as the colour, font and other visual appearance settings. 

The conversions list always has a first entry for modifying the output of null values. A null
value occurs when there is no data present for the cell. For example, instead of leaving the
cell empty you might decide to output a fixed string, such as ‘empty’, ‘null’ or ‘missing’. You
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might also alter the cell appearance by making the cell background red so that the absence of
data is brought to the attention of the user. By default the null conversion makes no changes
and so null values simply result in an empty table cell output.

To add additional conversions you need to click the button to the right of the Conversions tab
containing a green cross. Use the adjacent button with a red cross in order to delete a
conversion that is no longer required. Note that you cannot delete the null conversion entry.

Each conversion is applied to cell values that are less than its defined ‘If <’ field but greater
than or equal to the previous conversion in the list. The first non-null conversion is applied to
all values less than the specified value. Once a conversion entry has been selected you can
alter the visual appearance settings by using the settings in the lower half of the conversions
tab.

Item Description

If < The conversion is applied to cell values that are less than the value
entered here but greater than or equal to the value of this field for
the previous conversion entry. Note that the null conversion does not
have a field for entering a value because it is a fixed entry that is
applied automatically.

Then output Specifies the text to be output. Use the special placeholder $(Value)
to indicate where the actual cell value should be placed. This allows
fixed text to be placed before and/or after the placeholder. You can
omit the placeholder entirely if you want to output fixed text only.

Preview This is a read only field used to show a preview of how the output will
look given the current conversion settings.

Gradient By default this is not selected and so the conversion background
setting will be used. When selected the background of the cell is the
interpolated value between this conversions background colour and
the background colour of the previous conversion. This allows a
pleasing gradient effect.
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13.4.4.2.4  Footers Tab

The Footers tab is used to add rows to the bottom of a table. The tab itself is divided into two
additional tabs.

Rows Tab

To add a new entry you use the mouse to drag an item from the
Predefined tab and drop it onto the rows list. A new entry will
then be created and appended to the end of the current entries.

Predefined Tab

All possible footer functions are listed in this tab. Use the mouse to drag an entry onto the
Rows tab in order to add a new footer for output. You can modify the function used by an
existing Rows entry by selecting the Data tab and modifying the Function setting.
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13.4.4.2.4.1  Data Tab

When a Rows tab entry is selected this tab is shown and allows
settings related to generating the cell data to be modified. The
majority of the predefined options will output a numeric cell
value, such as the Average, Minimum and Maximum entries. A
few, such as Time of Latest and Time of Minimum, output a time
and date value. The available fields in the Data tab depend on
which output is being produced.

Data Value Types

Item Description

Label Text used in the row header.

Function Function used to calculate the cell value.
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Function Parameter This field only appears if you select a Rolling Function that requires an
additional parameter. For example, selecting a function of Nth
Maximum will show a rolling parameter labeled Nth.

Numeric Format Determines how the output value is converted into text. Predefined
settings such as General Number and Percentage can be used for
common requirements. If none of the predefined settings are
appropriate then use the Custom Format option in combination with
the following field.

Custom Format When the Numeric Format is set to Custom Format this setting is used
to define how a value is converted to text. You can specify the
number of decimal places, user of thousands separators and alternate
formats for positive, negative and zero values.

Time and Date Types
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Item Description

Label Text used in the row header.

Function Function used to calculate the cell value.

Date Format Determines how the date is converted into text. Predefined settings
such as General Date and Short Time can be used for common
requirements. If none of the predefined settings are appropriate
then use the Custom Format option in combination with the
following field.

Custom Format When the Date Format is set to Custom Format this setting is used to
define how a date is converted to text.
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13.4.4.2.4.2  Appearance Tab

Use the settings in this tab to modify the appearance of footer specific cells. By default all of
these settings are defaulted and so the settings are retrieved from the Default Appearance
section of the Table tab. 

When you change any of the settings it will only be applied to the selected footer row. For
example, if you have two footers defined and you modify the Text Colour of the first to be
blue the generated table will only have blue text in the first columns footer cells. The second
column footer cells will not be affected by the change.
If you modify a setting and need to set it back to the defaulted state you can use the red
button to the right of each property. 

Item Description

Column Width Defines the pixel width of the column.

Cell Colour Background colour of cells in the first, third, fifth row and so forth.  

Alternate Colour Background colour of cells in the second, fourth, sixth row and so
forth.

Text Colour Colour of cell text.

Font Family Font used for cell text.

Font Size Size of the font used for cell text.

Font Style Optionally draws the font in bold, italic and underlined.

Alignment Positions the text to the left, centre or right of the cell.
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Appearance Tab

13.4.4.2.5  Preview  Tab

The Preview tab is used to generate a table for immediate display so you can see how the

current settings generate output. 

This allows a quick development cycle, where settings are modified and then the effect on the

output can be previewed. Each time the preview tab is selected another preview will be

generated.
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Preview Tab Example

In the example image above the 'Max Data Rows' is used to
show the end of the data in the example. When the report is
generated the table will expand to include all of the rows

required for the report period.

13.4.4.3 Pictures

Graphic images can be added to a report by making use of the Image object. When selected a
dialog box will appear allowing you to select a file of format png, bmp, jpg or tiff. This feature
is useful for adding fixed images such as a company logo. 
Another use is for loading a satellite image of a data logger’s location and then overlaying a
wind rose graph, thus showing the physical location of data readings data.

When an image object is selected the following properties can be viewed and edited.

Item Description

Opacity A slider that allows the transparency of the image to be controlled.

Stretch Determines how the image is drawn when the object size does not exactly
match the image size.  Options include : -
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None – Image drawn as the original size.
Fill – Image stretched to both directions to match the available space.
Uniform – Stretched to match the smallest length that maintains aspect ratio.
UniformToFill – Stretched to match the longest length that maintains aspect
ratio.

Width Defines the pixel width of the object.

Height Defines the pixel height of the object.

Top Defines the vertical position of the object.

Left Defines the horizontal position of the object.

Try putting a map image behind a Wind Rose graph for added
detail. The opacity of the image can be altered so that it
doesn't obscure the graph.
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Polar Graph with image

For an example of the use of images in graphs see the file:
Polar Graph Example 

13.4.4.4 Shapes

Three simple shape objects are available for creating additional graphics that enhance the
appearance of reports. 

A Line object is useful for drawing a separator between different sections of a report. 
Ellipse and Rectangle objects are useful for drawing frames around areas or grouping together
related objects.

To add a shape object you must begin by selecting the appropriate shape option from the
Shapes drop down button on the Edit tab. Then move the mouse to the report canvas and
press the left mouse down to begin a drag operation. Continue moving the mouse until the
approximate required size of the shape is defined and finally release the mouse.

The ellipse and rectangle objects have the following properties that can be viewed and
edited:
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Item Description

Border Colour Colour used for the border around the shape, by default this is black.

Border Thickness Pixel thickness of the border, set to zero to remove any border drawing.

Fill Colour Inner colour of the shape, defaults to transparent.

Opacity A slider that allows the transparency of the image to be controlled.

Width Defines the pixel width of the object.

Height Defines the pixel height of the object.

Top Defines the vertical position of the object.

Left Defines the horizontal position of the object.

The line object has different properties; those not already listed are as follows.

Item Description

Line Colour Colour used for drawing the line.

Line Thickness Pixel thickness of the line.

Shape Objects

13.4.4.5 Text

Use the TextBox to display simple text output in a report. To add a new TextBox you must
begin by selecting the appropriate option on the Edit tab. 
Then move the mouse to the report canvas and press the left mouse down to begin a drag
operation. 
Continue moving the mouse until the approximate required size of the box is defined and
finally release the mouse.

Text Objects gives an overview of this object type.

TextBox objects are available in three types:

· Static Text Types

· Fixed Text Types

· Data Text Types

http://download.ecotech.com/Airodis%20Media/Media/Report%20Manager%20-%20Text%20Objects/Report%20Manager%20-%20Text%20Objects.html


157Report Manager

© Acoem and related entities 2023

Static Source Type

By default the TextBox will output static text that you have defined. To modify the static text
you can double click the TextBox and update the contents directly. 
Alternatively change the Text property that is shown in the properties window to the right
side of the report. 
Also note that all aspects of the text appearance can be controlled by using settings on the
ribbon or from the properties window. For example, the text colour, font size and alignment
are often customized.

Static type text is useful for creating titles, headers, footers and heading. On the first page of
the report you can modify the header and footer areas. 
Use the TextBox in these two areas to define titles that appear on each page of the generated
report. 

Fixed Source Type
To change the source type of the TextBox you must first select the TextBox using the mouse so
that the properties for the object are displayed in the properties window situated on the right
of the application window. Then click the button containing three dots inside the Source Type
property.

The displayed dialog can then be used to select the Fixed Output option of interest. A range of
fixed output values are available and all these values are determined at runtime. 
For example, the Page Number is useful when placed in the footer so that multi-page reports
can indicate the page number being output. 

The following table lists all options and what they output:

Item Description

Report Name Filename of the report, not including the path.

Report Created Time Date/time when the output is actually generated.

Data Run Time Date/time used as the basis for the report data period.

Data Start Time Starting date/time for the report data period.

Data End Time Ending date/time for the report data period.

Page Number Page number of the output this box appears on.

When you choose one of the Fixed Output options that will output a date/time an additional
Output Settings section is shown that allows you to format the date/time output. 
This can be seen in the following example:
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TextBox Source Dialog - Fixed Type

Data Source Type

Select this option when you need to output information about an individual Station, Report or
Channel. When selected the dialog shows a Data Output section allowing you to specify which
of the three possible sources of data is required. Depending on the source selected a list of
available data items for that source are shown.

If you choose a channel and then select the Channel Calculation data item then another
section titled Output Settings will be displayed. This allows you to define how the answer is
calculated for the selected channel. 

For example, you can use this to output the average for a channel. Note that the data period
covered by the selected function is that defined by the report itself.

The following example shows a channel calculation being setup with the following settings
available:

Item Description

Function Function used to calculate the cell value.
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Parameter This field only appears if you select a Rolling Function that requires an
additional parameter. For example, selecting a function of Nth
Maximum will show a rolling parameter labeled Nth.

Units Optional unit conversion can be applied by specifying the target units
needed. This is only applied is the channel has a defined units value
in the client application.

Valid Threshold Percentage of values that must be valid in order for an output to be
generated. If the percentage is not met then the output cell is left
blank.

Minimum Value Values must be greater than or equal to this setting to be valid.

Maximum Value Values must be less than or equal to this setting to be valid.

Numeric Format Determines how the output value is converted into text. Predefined
settings such as General Number and Percentage can be used for
common requirements. If none of the predefined settings are
appropriate then use the Custom Format option in combination with
the following field.

Custom Format When the Numeric Format is set to Custom Format this setting is used
to define how a value is converted to text. You can specify the
number of decimal places, user of thousands separators and alternate
formats for positive, negative and zero values.

TextBox Source Dialog - Data Type
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13.5 Layout Tab

This tab enables the user to define the overall layout of the report, the ribbon contains the
following menu items: 

Margins

A set of predefined margins are available, these include Normal, Narrow, Moderate and Wide.
 

Margin Description

Normal Top: 1", Bottom: 1", Left: 1", Right: 1"

Narrow Top: 0.5", Bottom: 0.5", Left: 0.5", Right: 0.5"

Moderate Top: 1", Bottom: 1", Left: 0.75", Right: 0.75"

Wide Top: 1", Bottom: 1", Left: 2", Right: 2"

 Note that the selection of margin type here will affect the
entire report.

Orientation

Portrait and Landscape orientations are available. Selecting either will cause the orientation
to be applied to every page in the report.
Note that when changing orientation the report objects on a page may not retain their
absolute positions but will be moved in order to fit them within the page boundaries. 

Size

A set of predefined page sizes are available, these include Letter, Tabloid, Ledger, Legal,
Executive, A3, A4 and A5.
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Headers

A set of Header templates is provided in a variety of styles. Selecting one of these templates
will apply that Header and Footer to the entire report.
The user may edit an applied Header or Footer by editing the objects within the Header or
Footer block on the first page of the report. 

Bring To Front

This menu contains two item:

· Bring to Front - brings the selected report object to the 'front' or 'top' of the report objects
order.

· Bring Forward - brings the selected report object forward one level

Send To Back

This menu contains two item:

· Send to Back - sends the selected report object to the 'back' or 'bottom' of the report objects
order.

· Send Backward - sends the selected report object backward one level

Watermark

The Watermark dialog allows the user to add or remove watermarks from the report.
Watermarks can be either Image or Text based. The watermarking results can be previewed in
the dialog.

 Note that any watermarking will be applied to every page of
the report.

Page Colour

The page colour can be changed using this menu item.

 
Note that the selected page colour will be applied to every
page in the report.
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13.6 Scheduler Tab

The Scheduler tab is used to view and manage schedules that automatically run reports on a
periodic basis. An individual schedule is associated with a single report but a schedule can
produce multiple types of output. So a single schedule could produce a Microsoft Word
document that is saved to a directory as well as a Microsoft Excel file that is transferred using
FTP to a remote server.

Schedule List View

Scheduling a Report provides details of the scheduling
process.

A list of all the currently defined schedules can be seen in the main area of the window. Each
line represents a single schedule definition. 
The different list view columns provide the following summary information about each
schedule.

Item Description

(Enabled) Indicates the enabled state of the schedule. A red circle indicates a
disabled schedule and a green circle used for enabled. Only enabled
schedules are eligible to be automatically run.

(Running) Shows the current running state. When currently being run a green
arrow will be drawn along with a percentage completed number.
Percentages are an estimate of how much of the total work has been
completed.

Report Directory path and name of the report associated with the schedule.

Retry If the schedule is due to be run but there is insufficient data available
the schedule will be delayed. This field indicates how many retries have
been attempted whilst waiting for data to be available.

Run Time Date and time when the schedule is next due to run.

http://download.ecotech.com/Airodis%20Media/Media/Report%20Manager%20-%20Scheduling%20a%20Report/Report%20Manager%20-%20Scheduling%20a%20Report.html
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Last Run Date and time when the schedule was last run.

Results Rectangles are used to show a summary of the last 15 results of running
the schedule. Green indicates no errors, red indicates at least one error
and yellow shows that there was insufficient data available. 

Results are ordered from left to right so that the most recent result is the
leftmost rectangle. Place the mouse over the rectangle for a tool tip
giving more detailed information about the results of that particular run.

To see all 15 results in one go you can click the magnifying glass button
on the right side of the field. This will show a dialog window.

Schedule Description of how often the schedule is run.

Destinations One image is used for each output type of the schedule. This allows you
to quickly see what type of output the schedule is setup to produce.
Place the mouse over the image to see a tool tip with detailed
information about the output settings.

Group Name of the group this schedule is associated with.

Schedule List Filtering

When you have a long list of schedules it can become difficult to find the schedule of interest.
Use the filtering controls located above the list view to reduce the displayed list to only those
required. 

Three types of filtering are available.

Item Description

Filter By Group As you type into this filter box it will remove all schedules from display
that do not contain the entered text in the group name. If you enter the
letter ‘x’ then only schedules with a group name containing the letter ‘x’
will be displayed.

Use the drop down arrow on the right side of the edit box to see a list of
all the available unique group names. This provides a quick way to select
a known group. To remove group filtering use the Reset button to the
right of the group filtering box.

Filter By Report This filter box will remove schedules that do not contain the entered
text in the report name. If you enter the letter ‘x’ then only schedules
with a report name containing the letter ‘x’ will be displayed.

Use the drop down arrow on the right side of the edit box to see a list of
all the available unique report names. This provides a quick way to
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select a known report. To remove group filtering use the Reset button to
the immediate right of the report filtering box.

Filter By Failed Use this filter to show only the schedules that have a failed result within
the specified period. For example, if you enter 2 hours then it will show
all the schedules that have a failed result within 2 hours of the current
time. 

A drop down arrow on the right side of the edit box shows a list of
common time periods. This provides a quick way to selecting a common
time period.

Unlike the other filtering options this filtering is only applied if you push
the Apply button to the immediate right of the edit box. To turn off the
filtering you need push the button again.

13.6.1 Managing Schedules

Use the menu items on the ribbon located at the top of the Schedules tab to invoke
management functions. 
Alternatively select schedules in the list view and then right click to show available options.

Item Description

Run Requests a schedule to be run as soon as possible. Any disabled state is ignored
allowing any schedule to be started manually.

Note that if the report scheduler is already working at maximum capacity the
requested schedule will not begin immediately. Instead it will be added to a
priority queue and started at the next available opportunity. 

The Schedule can be run immediately or it can be given a fixed end date or fixed
start and end date in the same way as the Preview works.

Cancel Aborts a running schedule. This is useful when you have a long running schedule
that needs to be stopped so that changes can be made to the schedule settings
before starting it again.

Paused Use this global setting to prevent schedules from starting to run. Existing
schedules will continue running to completion. Click the button a second time
to remove the paused state and return to normal operation.

Add Allows the creation of a new schedule. See the following section called Defining
Schedules for detailed information about creating a schedule.

Edit Modify an existing schedule by selecting an entry in the list view and then
clicking this button. 

Delete Permanently remove one or more selected schedules.

Clone Makes a copy of one or more selected schedules. Note that the new copies will
differ only in the label name. Each copy has the word ‘Copy’ appended to the
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copy so that they can be distinguished from the originals.

Enable Sets the single selected schedule to be enabled.

Disable Sets the single selected schedule to be disabled.

Enable All Sets all the selected schedules to be enabled.

Disable All Sets all the selected schedule to be disabled.

Schedule Used to perform a batch change to the next run time of multiple schedules. See
the Batch Rescheduling section for more details.

Settings Global settings used in the handling of insufficient data checks.

13.6.2 Defining Schedules

Use the Add button to start the process of creating a new schedule. This will show a dialog
window that allows all aspects of the schedule to be defined. 

The first field is labeled Report and is the name of the report to be. This field is mandatory and
can be defined by clicking the Browse button to the right of the field. 
Below is the Group field that is used to associate a group name with the schedule. You should
use the same group name to associated related schedules together.  Use the group filtering
capability, presented as a Combo Box above the list view, to remove all but the schedules of a
particular group. This makes it quick and easy to filter down a long list of schedules to just the
group of interest.

The main area of the dialog contains two tabs; a Schedule tab that is used to define when the
schedule will be run and a Destinations tab that defines the output that is generated.
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13.6.2.1 Schedule Tab

A schedule can be configured to recur at different intervals. The left side shows a list of the
possible recurrence intervals. 
On the right are settings relevant to the currently selected recurrence. 

Three of the settings are common to all the recurrence intervals. 

Item Description

Next Defines the date and time when the schedule will be run. You
should set this the first time you define a schedule. This value is
automatically updated each time the schedule runs according to the
recurrence specific settings.

Enabled Schedules are only eligible to be run if they are enabled.

Check for sufficient data When selected the schedule will only execute if data is available for
the entire reporting report as defined by the report. For example, if
you have a report with a reporting period of the last hour then all
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the station channels used by the report must have data that covers
that last hour.

See the section on Global Settings for more information on how
checks for insufficient data are configured and handled.

Run at Startup When ticked this schedule will be run if the Report Scheduler is
restarted instead of waiting for the next schedule time.

Skip intermediate data
periods

Selecting this option will skip any scheduled report outputs
between the last scheduled time and the current time in the case of
the Report Scheduler being stopped and restarted.
For example a report scheduled for every minute for output to a
screen will be run 60 times if the Report Scheduler was stopped and
restarted an hour later. In this case it is pointless catching up with
the schedules for this report and running these extra reports will
cause unnecessary overhead on the scheduler. 
Ticking this box will prevent the scheduler trying to catch up.

Available recurrence options are:-

Item Description

One Time The schedule will execute once at the time specified in the Next field and will
then be automatically disabled. To run the schedule again the user needs to
update the Next value and re-enabled the schedule.

Minutely Each time the schedule is run the Next field is automatically moved forward a
user defined number of minutes. For example, you would use this option to
generate a report every 10 minutes.

Hourly Each time the schedule is run the Next field is automatically moved forward a
user defined number of hours. For example, you would use this option to
generate a report every 4 hours.

Daily Each time the schedule is run the Next field is automatically moved forward a
user defined number of days. For example, you would use this option to
generate a daily report.

Weekly You can specify how many weeks to increment the Next field by as well as the
days of the week the schedule is eligible for. For example, you could run the
report every week on a Tuesday or every other week on the Friday and
Saturday.

Monthly You can specify which months of the year the schedule should be run on. Within
those months you have two options. Either specify a list of days or indicate an
individual occurrence of a week day. An example of the first use would be a
schedule that runs on the 1st of each month. The second option would be the
first Saturday of each month. 

On
Download

Every time the Download Server downloads from one of the stations used in
this report the report schedule will be run if one or more conditions are met.
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On Download Schedules

On Download Schedule Options

Item Description

Station This field displays all of the stations used in this report. Select one from the
dropdown list to display further options below. 

Event The Event field specified the event or events associated with the selected
station that will cause the report to be run. Events include:

· Download Complete

· Alarm Raised

· Alarm Cleared

· Alarm Raised or Cleared

Rules The Rules field allows the user to select the rule or rules that will trigger the
report schedule if the Event is an alarm raised or cleared.
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The "Override report start and end dates to reflect the alarm period" check box, if ticked, will
cause the report to be run for the duration of an alarm such that the report only shows the
duration that the alarm has been triggered for.

13.6.2.2 Destinations Tab

The Destinations tab is used to define the actions to perform when the schedule is run. You
can specify any number of different actions to occur for the same schedule. So a single
schedule could generate multiple output files such as Word, Excel and HTML each time it runs.
Although in practice the majority of schedules only produce a single output.
To add a new destination click one of the File, Screen, Email, FTP or Serial buttons listed down
the left side of the page. Remove an existing destination using the Delete button. When a
destination is selected you will see a group of properties displayed on the right of the page.
The properties will vary depending on the destination type.

Available File Formats

Airodis can output reports in the following file formats:

Item Description

Microsoft Word Outputs with DOCX extension. Can be opened by Microsoft Word 2007 and
later versions. See also: Open Office XML

Microsoft Excel Outputs with XSLX extension. Can be opened by Microsoft Excel 2007 and
later versions. Note that only tables will be generated with one Excel Sheet
for each table in the report. 

Adobe PDF Portable Document Format output can be opened by Adobe Reader or any
of the many commercial or free versions of PDF readers.

JPG 
PNG
BMP 
TIFF 
GIF

Several popular different graphic formats are available. You should choose
the appropriate format for your own specific needs. Note that there will be
one output file per report page. So if you report has 3 pages there will be 3
output files, one for each page.

EMF Enhanced Windows Metafile is a vector graphics format. Many graphics
packages such as Microsoft Office, Adobe Illustrator and Coral Draw can
open and display the EMF format. Note that there will be one output file
per report page. 

HTML Hypertext Markup Language. Can be opened by internet browsers such as
Internet Explorer and Mozilla Firefox. All report elements are converted
into images and then embedded into a single HTML file.

CSV Comma Separated Values. Can be opened by Excel, Open Office, Libre
Office and any text editor. Note that only tables are output and there will
be one output file per table defined in the report. 

http://en.wikipedia.org/wiki/Office_Open_XML
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TXT Outputs with TXT extension. There will be one output file per report page
and only tables and text box elements will be converted into text and
output. This is a special output format that is used in conjunction with the
Serial destination.

13.6.2.2.1  File Destination

Output is generated and saved to a specified file. Note that the output directory is relative to
the machine that is running the Report Scheduler service. If you are running the Report
Scheduler on a different machine to the Report Manager then ensure the directory you specify
is correct for the Report Scheduler machine.

Item Description

Format The file format required. See the Available File Formats section for a full
list of all available formats and restrictions that different formats
impose.

Compression Relevant to text file outputs this option allows the following
compression types  to be applied to the data:
o GZip
o Deflate
o Snappy

Directory Target directory for the output file.

Filename Name of the output file, including the extension.

Append timestamp When selected a timestamp is appended to the end of the filename. For
example, the ‘out.bmp’ filename could be configured to output with the
current date, such as ‘out 17-04-2012.bmp’.

Use UUID Selecting this option will generate a unique filename identifier in the
form of 'd26d0468-254b-11eb-adc1-0242ac120002'. This is useful as an
alternative to appending the timestamp when needing a unique
filename.

Timestamp Determines how the date and time are converted into text. Predefined
settings such as General Date and Short Time can be used for common
requirements. If none of the predefined settings are appropriate then
use the Custom option in combination with the following field.

Custom When the Timestamp is set to Custom Format this setting is used to
define how a date is converted to text.

Post-Process
Command

The command to be executed to perform further processing of the
output file. This can be an executable or a windows batch script. The
command will be executed once for each output file. 

Environment variables may be used in the command. The following
extra variables are added to assist in task automation:
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%filedir%  - The directory containing the file (e.g. "C:\Reports")
%filename% - The base name of the file without the extension (e.g.
"Output")
%fileext%  - The file extension(e.g. ".png")
%filepath%  - The full path and filename (e.g. "C:
\Reports\Output.png")
%contenttype% - The MIME type of the output file (e.g. "image/png")

Note:
"%filepath%" == "%filedir%\%filename%%fileext%"

Example command to convert a file using ImageMagick:

convert.exe -quality 50 "%filepath%" "output.jpg"

The following options are only used when generating output that will be used in association
with Acoem Australasia cloud products.

These include file formats:
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CZML
o Cesium CZML - Outputs a radar report to a CZML file which can be used with any supported

viewer (E.G Cesium).
o HTDM CZML - Special variation of Cesium CZML which uses data exports for Haul-Truck

specific data.
Avro
o Airodis Cloud - Generic export for geospatial information.
o Airodis Cloud (Lidar) - Special variation for radar report using Lidar.
o Airodis Cloud (HTDM)  - Special variation for HTDM data.

Note: They are currently for internal use only.

Cloud Options
Only visible when using the appropriate format above

Item Description

Organization Id The identifier for the organisation as it is identified in the cloud.

Datasource Id The identifier for the datasource associated with the above organisation.

Lidar Type The Lidar Scan Type of the data:
o Beta
o Doppler
o Mass

Individual DT Individual DateTime gives every data point its own individual timestamp
as opposed to the usual Lidar scan data where the entire scan has the
same timestamp. This option is usually used in CZML output.

13.6.2.2.2  Screen Destination

The generated output is created and then displayed using a desktop window. If there is
already a window showing output from the last time the schedule ran then the window will
be updated to show the latest results. By combining a schedule running every minute with a
screen destination you can achieve a real-time view of a report.

Note that the following set of display options are only applied when a new desktop window is
needed. If an existing window is showing output for a schedule then that existing window is
used and the display options are ignored.

Item Description

Full screen This is the default screen sizing option. It will cause the desktop window
created to be maximized to the entire screen.

Manual Use this option to prevent the full screen display of results. When
selected you should modify the size and position values so that the
created desktop window appears as required.

Single page This is the default page showing option. When the desktop window is
created this is the page number of the report that will be initially
displayed.



173Report Manager

© Acoem and related entities 2023

Slide show pages Use this option to automatically move from page to page of the report. 
Set the interval to define how long each page is displayed. 

Destination A comma separated list of user/machine destinations. 

A screen destination will cause a desktop window to be created showing the pages of the
generated report. 
The report can be sent to many destinations by adding additional user and machine
combinations in the Destination box.
All of the destinations for that schedule will receive the same report with the same screen
properties. If multiple users
want to receive the same report but with different screen configurations then they should be
scheduled separately. 

A tool bar at the top of the page allows the report result to be manipulated.

You can save the current page as a PNG graphics file use the first button on the tool bar. To
print individual pages or all pages at once, you can use the second button with a printer icon.
Use the blue arrow buttons to move between pages or enter a specific page number in the
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text box to navigate directly to a page. The green arrow towards the right of the toolbar is
used to start the slide show feature; this automatically displays each page in turn until the red
button is pressed to stop the slide show.
The status bar at the bottom of the page allows the zoom level to be changed.  

13.6.2.2.3  Email Destination

Output is generated to a temporary file and then emailed to the designated recipients. The
temporary file is deleted once the email request has been completed. Use the Filename
Properties section to define the type of file generated and emailed. Detailed information
about the file properties section can be found in the File Destination documentation.

Item Description
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To Semicolon separated list of recipients for the email.  This field is mandatory and
if left blank will generate an error when you try and close the dialog.

CC Semicolon separated list of recipients to be provided a copy of the email.

BCC Semicolon separated list of recipients to be copied the email but which To and
CC recipients will be unaware received a copy.

Subject Description that will be used as the subject field of the email.

13.6.2.2.4  FTP Destination

FTP (File Transfer Protocol) output is generated to a temporary file and then transferred using
FTP to a remote server. The temporary file is deleted once the FTP request has been
completed. Use the Filename Properties section to define the type of file for generation and
transfer. Detailed information about the file properties section can be found in the File
Destination documentation.

Item Description

Protocol
· FTP
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o The default - no encryption

· FTPS
o FTP with added SSL (Secure Socket Layer)

· SFTP
o FTP based on the SSH (Secure Shell) network protocol

Hostname Provide either an IP Address such as ‘192.168.0.0’ or a domain name such
as ‘server.com’.

Port Port number to use when connecting. Most FTP servers use port 21.

Enabled SSL When enabled this will encrypt all communication with the server,
including sending the username and password. Note that the server must
also be enabled for SSL in order for a secure connection to be made.

Passive Mode This method of connecting needs to match the settings of the server for a
successful connection to be made. Only available for FTP and FTPS
selections.

Directory Target directory on the FTP server. 

Username Username required to logon to secure servers.

Password Password required to logon to secure servers.

More information on FTP can be found here: Wikipedia FTP Entry

http://en.wikipedia.org/wiki/File_Transfer_Protocol
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13.6.2.2.5  Serial Destination

Serial Destination generates a text file and then sends it to a designated COM port. There are
multiple settings required to successfully setup a serial port and care must be taken to ensure
your settings match those of the connected device. Consult the documentation of the
connected serial device so a connection can be established.

Item Description

Port name Name of the COM port to use for communication.

Baud rate Defines how many bits per seconds are transferred.

Data bits Number of data bits per character.

Stop bits Number of bits that mark the end of data.

Parity Error checking procedure to use.

Handshake Specifies the handshaking used to manage the transfer of data.

When using a serial destination the only allowed output type is TXT. This involves converting
each report page into a single text file that is then sent over the serial port. Note that only
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tables and text boxes can be converted to text.  Graphs, images and other graphics elements
cannot be converted to text and so are ignored.
The following settings are used to control how the report is converted to text.

Item Description

Columns per inch The number of columns per inch of width is used to decide
how a report character is positioned into a column of the
output. 

Rows per inch The number of rows per inch of height is used to decide how a
report character is positioned into a column of the output.

Output empty lines Determines if lines that have no text are output.

Trim space from end of lines Determines if the whitespace at the end of each line should
be removed or left in place.

Append CR/LR to each line Determines if each line should have a CR/LF pair of characters
appended.

The columns and rows per inch are important because they determine how a character in the
report is positioned in the output file. If these values are too small then multiple characters in
the report will be placed in the same output position, resulting in characters overwriting each
over and so the output will have missing characters. If the inch settings are too large then
there will be spacing gaps between some output positions.
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13.6.3 Batch Rescheduling

To update the Next Run Time of multiple schedules you can use the batch rescheduling feature
that is started by clicking the Schedule button on the ribbon of the Scheduling tab.

Match Schedules

First you need to define which schedules are going to be modified. Select the required
frequency of the schedules that will be matched using the Minutely, Hourly, Daily or Weekly
radio buttons as shown in the following image.



180 Airodis Manual

© Acoem and related entities 2023

The Recurrence field is used to narrow down the set of schedules that are matched. For
example, in the above image only daily schedules that have a recurrence of 1 will match. Any
schedule that is daily but with a recurrence of 2, 3 or any other number excluding 1 would not
be matched.

Schedule Update

Schedules that are matched are updated according to the number of intervals specified in the
Reduce intervals field. Note that the number of intervals is the number of recurrence intervals
to be subtracted from the Next Run Time field of each schedule. 

This can be confusing when first used and so a short text description is presented underneath
the input field to describe the action that will be taken. In the above example the recurrence
(1) is multiplied by the intervals (5) to give the total number of days (1x5 = 5) subtracted from
each schedule run time.

Make sure you double check all the settings before pressing
OK. Using the wrong details will result in a considerable
amount of time wasted in manually updating schedules to

correct a mistake.

13.6.4 Global Settings

Clicking the Settings button on the Schedule tab ribbon will show the dialog used to define
global settings that are applied to all defined schedules. 

Retries
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When a schedule has the Check for insufficient data option enabled an extra processing step is
performed when the schedule is run. 
A check is made that data is available for the entire reporting period of each report object
(table, graph, text box etc) that is defined. 
This ensures the report is only run if the expected data is present. If all the data is available
then the report is run as normal. 
If there is insufficient data then the global settings are used to decide how to proceed.

Each frequency period has a delay interval that is applied when insufficient data occurs. The
running of the schedule will be delayed for that period of time and then retried. 
The number of retries is also defined. 
For example, the image below shows that an hour frequency schedule will  wait 5 minutes
before retrying and will retry 3 times before finally aborting the scheduling attempt.

Global Settings - Retries Tab

Concurrency

The Concurrency setting relates to the number of schedules that can be run at any one time.
As a rule of thumb this could be set to the number of cores the host machine has in its
processor.
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If this number is set too high and a large number of schedules are run frequently then the user
may see a 
decline in machine performance.

Should the user have this value set to two and four schedules are due to be run then the first
two will start and the
remaining two will be queued. If at this time the user decides to manually run a schedule then
this schedule will be 
pushed to the front of the queue such that when either of the initial two schedules are
finished the manual schedule 
is run next followed by a queued schedule.

This would just leave a single queued schedule and the user doesn't have to wait for all
queued schedules to finish before
their manual schedule can be run.

Setting the concurrency value too high can have a
performance impact on the Report Scheduler.
The concurrency number should relate to the number of

processor cores available.

Global Settings - Concurrency Tab
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Output DPI

This tab is for users who wish to produce reports with a higher Dots Per Inch (DPI) setting.
The default is 96, which should be adequate for most users, but this can made as high as 1200.

Setting the DPI value too high can cause the host machine to
run out of system memory when processing large reports.
This is more of a problem on 32 bit machines where the

Windows .Net process memory limitation stands at around 1.2 GB.

Global Settings - Output DPI Tab

13.7 Calculated Channels Tab

A calculated channel is a user defined formula that computes an output based on a set of one
or more other channels. This allows calculations to be integrated into the results of tables and
graphs.

http://en.wikipedia.org/wiki/Dots_per_inch
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Calculated channels are associated with a particular report. Creating a new blank report will
result in starting with no defined calculated channels. Copying an existing report will result in
the copy having the same set of calculated channels as the original. Definitions can also be
moved from one report to another by using the export function from one report and then
opening another report and using the import function.

The Calculated Channels tab shows a list of the current definitions. Some of the calculated
channel settings such as Label, Description and Calculation are shown in the display list for easy
reference. 

Calculated Channels Munu

Calculated Channels gives an overview of the creation,
testing and use of Calculated Channels.

Managing Calculated Channels

Use the large buttons on the ribbon at the top of the Calculated Channels tab to perform
management functions. 
Alternatively you can select channels in the main area using the mouse and then right click to
show the available functions.

Item Description

Add Shows a dialog for defining a new calculated channel.

Edit Shows a dialog for editing the selected calculated channel.

Delete Permanently removes the selected channels.

Clone Makes a copy of the selected channels but with new labels.

Import Imports all the calculated channels found in a specified xml file.

Export Exports all the calculated channels to an xml file on the local machine.

Templates Displays the Templates dialog in which new and existing templates can
be edited.

http://download.ecotech.com/Airodis%20Media/Media/Report%20Manager%20-%20Calculated%20Channels/Report%20Manager%20-%20Calculated%20Channels.html
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13.7.1 Defining Calculated Channels

Use the Add button to start the process of creating a new calculated channel. This will show a
dialog window that allows all aspects of the channel to be defined. Two of the fields are
mandatory and the dialog will not allow the channel to be created until they have been
specified. 

The first of these is the Label field that must contain a valid name, it cannot be left blank.
Second is the Formula field that must reference at least one input channel. The input channel
can be either a station channel or another calculated channel. This means you cannot specify a
Formula that contains just a number or other fixed arithmetic calculation.

To help with spotting errors in your formula a feedback message at the top of the formula
editing area is displayed. If a valid formula is entered it will indicate this with a green tick,
green background and appropriate success message. An error is indicated a warning icon,
yellow background and error message giving specific details of the problem. You must correct
any error before the dialog will allow the calculated channel to be saved.

Item Description

Label Display name of the channel, used as the default name when added as a
column in a table or as a series in a graph.

Description Text describing the purpose of the channel.

Rolling Interval Time interval over which the rolling calculation operates.

Rolling Calculation Function used to calculate each output value.

Output Interval Time interval for that each output value represents. Usually you would
specify the same value for this field as the Rolling Interval.

Output Unit Units used for each output value.

Minimum Data Values are only output if the output interval contains this percentage of
valid data. Otherwise a null value is output.

Calculation Tab This area is used to define the formula. It contains the Edit tab,
Expanded tab plus sections labelled Operators, Functions and Channels.

Testing Tab To help with testing a complicated formula this tab allows the user to
enter test values for each of the input channels. The calculated result is
displayed and can be compared to the expected result in order to
confirm the formula is working as expected.

Edit Tab Contains a large multiline edit box that is used to specify the formula. It
is advisable to split a complicated formula into sections and use
whitespace formatting to make this easier to read.

Expanded Tab Contains a read-only version of the formula but colour coded to make it
easier to see the different elements that make up the formula. Input
channels are also converted from number representations to the actual
names of the channels.

Operators A set of buttons for inserting common operators into the formula.
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Functions A set of buttons for inserting common functions into the formula.

Channels Select an input channel using the drop down combo box and then press
the insert button to add that channel into the formula being edited.

Templates Select a calculation from a predefined template.

Invalid/Null Values This item allows the used to specify how the Calculated Channel should
deal with invalid and null values. The options are:
1. Invalidate Equation - This is the default option. If any of the

dependent channels have a Null or Invalid value the calculated
channel will be invalidated and the result will be Null.

2. Include Invalid Values - This will use Invalid values in the calculation
but will exclude Null values. This could be used when reporting on
Span data.

3. Substitute Value - When selected the user can enter a number that all
Invalid and Null values will be substituted with.

Calculated Channel Definition
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13.7.2 Testing Calculated Channels

Select the Testing tab within the calculated channel definition dialog in order to begin testing
the currently defined formula. In the upper half of the tab a colour coded version of the
formula will be displayed with the input channels converted from numbers into text
descriptions. This makes it easy for you to check that the input channels are the ones required.

The lower half will show a list of the input channels and an input box. Use the input box to
enter a test value for that individual input channel. Enter values for each of the input channels
and then check the formula result in the Test Result area at the bottom of the tab. The result
will be updated automatically each time you alter the input channel values.

In the example image below you can see that the formula is adding two input channels
together and then dividing by 2. The top half shows the input channels by name instead of
internal identifier, so I can confirm the correct channels are being used for input.  Below the
number 6 and 3 have been entered as test values. My expected result of (6 + 3) / 2 = 4.5 is
confirmed by the Test Results output.
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13.7.3 Calculated Channel Logic

There are a number of Functions and Operators that can be applied to Calculated Channels.

Code Comments

Code comments can be added to Calculated Channel logic by enclosing them in # characters

Nested IF Functions

The IF function takes the following form: IF(,,), which means:

IF(Expression, result if Expression is True, result if Expression is False)

This example will demonstrate how the IF function can be nested. A Calculated Channel called
Limit Temperature has been created and will be graphed against a temperature channel. We
will limit the high and low values of the temperature channel using the Limit Temperature
channel. 

The outer IF function checks if the temperature is above 26 degrees or below 14 degrees. If it
falls outside these limits then the logic from the inner IF function will be applied, if it is inside
these limits then the result will be the temperature as it is.
The inner IF function checks to see if the temperature is above 26 degrees, if it is then the
output is limited to 26 degrees. If the temperature is below 26 degrees it must then be below
14 degrees so the output is limited to 14.

# Check if temperature is above 26 or below 14 degrees #

IF($(1048581) > 26 OR $(1048581) < 14,

# Temperature > 26 OR < 14 #

IF(

# Temperature > 26? #

$(1048581) > 26, 

# Limit to 26 #

26, 

# Else limit to 14 #

14

),

# Temperature Not > 26 NOR < 14 - Output original value #

$(1048581)

)

In its expanded form the logic is as follows:

# Check if temperature is above 26 or below 14 degrees #
IF([1: Ooze Lake / Report 1 / 8: AT] > 26 OR [1: Ooze Lake / Report 1 / 8: AT] <
14,

# Temperature > 26 OR < 14 #
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IF(

# Temperature > 26? #

[1: Ooze Lake / Report 1 / 8: AT] > 26, 

# Limit to 26 #

26, 

# Else limit to 14 #

14

),

# Temperature Not > 26 NOR < 14 - Output original value #
[1: Ooze Lake / Report 1 / 8: AT]
)

The result can be graphed like this:

See this example in the file: Linear Graph Example  
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13.7.4 Templates

Calculated Channel Templates serve as a quick and easy way of generating and using
frequently used calculations.
They are a descriptive prompt as to how the Calculated Channel should be constructed.

The Template is stored as free text and when used, appropriate substitutions must be made to
make the calculation valid. Consider the following simplistic example:

Calculated Channel Template

We are creating a template to convert from ppm to mg/m3. The calculation is: [Parts in ppm] *
[Molecular Weight / 24.45]

When we come to use this template we need to substitute:
1. [Parts in ppm] with the Channel in ppm
2. Molecular Weight with the appropriate MW of the element we are working with
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13.8 AQS Reports

Airodis supports creating reports compatible with the US EPA's Air Quality System (AQS) and the
AirNow-I System.

Creating an AQS Report
To create an AQS report, select AQS Report from the File -> New menu. A new report will be created
and you will be taken to the edit page. Note that AQS reports cannot be previewed inside the Report
Manager. They must be executed by a scheduled job.

AQS Report Parameters
AQS Reports are comprised of date range parameters, site parameters and a channel list (each
channel has additional parameters).

Example AQS Report

Parameter Description

Date Range This is the date range which the report use when a scheduled run is
executed. For more information, see How Report Data Periods
Work.

Country AQS Country Code.
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State AQS State Code. State code allocations only exist for the United
States.

County AQS County Code. County code allocations only exist for the United
States.

Site The 4-digit site identifier or the 1-3 digit Tribal Code. This only
applies to the United States.

Is Tribal Select this box if the site code is a tribal code. This only applies to
the United States.

Null Data Code This is the default qualifier code that will be applied to null or
invalid data that has not been explicitly assigned a qualifier
through data validation in the Client.

AQS Channel Parameters
Channels are added to an AQS report by dragging and dropping channels from the tree of
available channels. Once a channel has been added, the parameters can be modified.

Parameter Description

Station
Report
Channel

The Airodis channel. This cannot be modified once the channel has
been added.

Parameter The AQS parameter code for the parameter being measured.

Unit The unit of measurement for the parameter being measured.

AQS Duration The data interval for the parameter being measured. Note: Airodis
will not re-average data to this duration. This is simply a meta tag
for the raw data.

ANI Duration The data interval for the parameter being measured (in minutes).
This only applies when outputting in the AirNow-I format. Note:
Airodis will not re-average data to this duration. This is simply a
meta tag for the raw data.

POC Parameter Occurrence Code. If a single site takes multiple samples
of the same parameter, the POC is used to uniquely identify each
instance. Set this to a unique number for the parameter being
measured.

Method AQS Method Code. See the US EPA's Valid Combinations of
Parameters document for more information.

Decimal Places The number of decimal places values are rounded to in the output.

Generating an AQS / AirNow-I Report
AQS and AirNow-I Reports are generating by Defining Schedules on the Scheduler Tab. AQS
reports are written to a file, which can then be saved to the hard drive, emailed or uploaded
to an FTP server.
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There are three output formats available:

Format Description

AQS The current AQS standard. This will output an XML-compliant
document.

AQS (Legacy) The legacy AQS Standard. This will output a pipe delimited  text
file.

AirNow-I The AirNow-I report format. This will output a comma delimited
text file (CSV).

13.9 Data Export Reports

Airodis supports exporting data in various formats. A data export report allows a user to select
channels to export, perform aggregations and calculations, and customise the output columns.

Data exports work in a row-based fashion (also known as de-normalised). There is typically no
header row, as each value is output on its own row alongside the information required to identify the
channel.
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Creating a Data Export Report
To create a Data Export report, select Data Export from the File -> New menu. A new report will be
created and you will be taken to the edit page. Note that Data Export reports cannot be previewed
inside the Report Manager. They must be executed by a scheduled job.

Data Export Report Parameters
Data Reports are comprised of date range parameters, a column list and a channel list
(columns and channels have additional parameters).

Parameter Description

Date Range This is the date range which the report use when a scheduled run is
executed. For more information, see How Report Data Periods
Work.
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Time Zone This is the time zone that the report will use when calculating start
and end dates.

Time zone conversion This will convert all data into the local time of specified time zone.
DST will be applied. Note that some file formats only support UTC,
in which case this option has no effect.

Minimum Data The minimum capture percentage to be used when re-averaging
data. Data with capture a rate below this threshold will be
excluded.

Columns
This list defines the columns which are exported in the chosen data format. These can be
timestamps, values or static text.
Click 'Add column' to add a new column to the report.

Parameter Description

Name The name of the column. This may appear in the header of the
exported file, depending on the file format being exported.

Type The type of field to be exported in this column.

· Static - This will output the text entered into the "Format" field
verbatim.

· Timestamp - This will output the row timestamp in the format
specified in the "Format" field. Note that not all output file
formats support formatting of timestamps.

· Channel Value - This will output the channel value in the format
specified in the "Format" field. Note that not all output file
formats support formatting of values.

· Static (Per Channel) - This will add an extra option to each
channel to output a static text value. This is typically used for
outputting channel identifiers when multiple channels are
defined.

Format Extra details on how to format the field. This is different for each
type.

Null Data Code For a "Channel Value"  column, this is the text value to be used to
represent a null value. This is typically blank, "NULL", or a
substitute number such as "-9999".

Channels
Drag and drop the channels to be exported.

Parameter Description

Channel The name of the column. This may appear in the header of the
exported file, depending on the file format being exported.
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Calculation Enter the calculation to be used for this channel. By default it will
output a fixed average. Set this to "Latest" to disable averaging and
output raw values.

Interval The output interval for this channel. A row will be output for this
channel at this interval, re-averaged to the specified calculation.
When exporting raw values, this must be the same interval as the
channel being exported.

Static Columns More columns will appear here if you have a "Static (Per Channel)"
column defined above. Enter the necessary text to identify this
channel.

Generating a Data Export Report
Data Export reports are generating by Defining Schedules on the Scheduler Tab. Data reports
are written to a file, which can then be saved to the hard drive, emailed or uploaded to an FTP
server.

There are four output formats available:
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Format Description

Avro The AVRO file format. This includes all headers, and works well
with "deflate" compression when pushing data to cloud services
such as Google BigQuery or PubSub.

CSV RFC4180 compliant comma separated values.

XML Generic XML format.

Hydrotel Hydrotel XML format.
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14 Web Module

Airodis Web Module

The Airodis Web Module component allows a user to run and publish reports via a web
interface. A user can log in to run a selected report, and also create permalinks for embedding
in an external web site. This is an additional module that is separately licenced and requires a
separate installer.

Logging in to the Airodis Web Module

If you are running the Airodis Web Module locally, you can access the web interface through
any modern web browser from the following URL:

http://localhost/

This URL will be different if the Airodis Web Module is running on a different machine. Check
with your system administrator for the URL.

Web Module Login

Generating a Report

Once you have logged in, select a report using the browser. You can then specify the report
parameters.

Field Description

Output Format Select the desired output format of the report. All of the standard
report output formats from Airodis are supported in the web

http://en.wikipedia.org/wiki/Permalink
http://localhost/
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module.

Run At Date This will run the report at a specific date. The start date will be
calculated based on what is defined in the report.

Run With Fixed Dates This will run the report for a fixed date range. The report start and
end dates defined in the report will be overridden with the
specified values.

Select Report

Once the report parameters have been set, click the ‘Run’ button to generate the report.

View Report
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Depending on the output format, the link may open in a new browser tab or prompt to be
saved to disk or opened by an external application.

Embedding Reports in a Website

After generating a report, the permalink can be embedded in a website. By default, the report
can only be viewed by users that have permission to run the report from the Airodis Web
Module, while they are logged in. To publish the report to a wider audience, the IP access
range must first be widened. See Report Properties for details on report security.

Manipulating Permalinks

A typical permalink is a URL with additional parameters to specify the report to be run, the
date range and the output format. Example:

http://mycompany.com/AirodisReport/JobSubmit.ashx?report=Airodis+Example+Reports%
5c1+-+Ooze+Lake%
5cLinear+Graph+Example.xml&start=1352393024&end=1352306624&format=png&seq=Page1

Permalinks can have the following parameters:

Parameter Mandato
ry

Description

report Yes The path to the report to be executed.

start No The start date of the report in Unix Time. If this is omitted, the start
date will be determined by the report definition.

end No The end date of the report in Unix Time. If this is omitted, the end date
will be the current date and time.

format Yes The output format of the report (e.g. png, csv, doc etc.). ‘png’ is
recommended for embedding images into websites.

seq No Sequence ID. On a multi-page report, this determines which page is to
be displayed. If omitted, the first page will be displayed.

callback No For JQuery support, add "format=json&callback=?" when integrating a
permalink.

Note: The start and end parameters will not have any effect unless "Allow Custom Date
Range" has been checked in the report properties.

There are many online tools available for calculating Unix
Time. Unix timestamps are a floating point value
representing the number of seconds that have elapsed since

midnight on 1st January, 1970 at UTC+0.

http://mycompany.com/AirodisReport/JobSubmit.ashx?report=Airodis+Example+Reports%5c1+-+Ooze+Lake%5cLinear+Graph+Example.xml&start=1352393024&end=1352306624&format=png&seq=Page1
http://mycompany.com/AirodisReport/JobSubmit.ashx?report=Airodis+Example+Reports%5c1+-+Ooze+Lake%5cLinear+Graph+Example.xml&start=1352393024&end=1352306624&format=png&seq=Page1
http://mycompany.com/AirodisReport/JobSubmit.ashx?report=Airodis+Example+Reports%5c1+-+Ooze+Lake%5cLinear+Graph+Example.xml&start=1352393024&end=1352306624&format=png&seq=Page1
http://en.wikipedia.org/wiki/Unix_time
http://en.wikipedia.org/wiki/Unix_time
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Embedding Permalinks in HTML

The permalink can be embedded as an image or as a hyperlink. Here is an example of how to
do both:

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN"
"http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd">
<html xmlns="http://www.w3.org/1999/xhtml" >
<head>
    <title>Permalink Example</title>
</head>
<body>
    <h1>Permalink Example</h1>
    <a href="http://mycompany.com/AirodisReport/JobSubmit.ashx?
report=Airodis+Example+Reports%5c1+-+Ooze+Lake%
5cLinear+Graph+Example.xml&format=doc">Download in MS Word</a>
    <img alt="Airodis Example Report"
        src="http://mycompany.com/AirodisReport/JobSubmit.ashx?
report=Airodis+Example+Reports%5c1+-+Ooze+Lake%
5cLinear+Graph+Example.xml&format=png" />
</body>
</html>

When viewed in a web browser, the page will appear as below:

Permalink Example
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15 Appendices

15.1 Appendix A - Date and Time Formats

To Format Do This

Numbers Use predefined Numeric Formats provided, or enter a specific
numeric format.

Dates and times Use predefined date/time formats Airodis provides, or enter a
specific date/time format using the following guide.

Date/Time Format
The following table identifies characters you can use to create user-defined date/time
formats:

Character Description

: Time separator. In some locales, other characters may be used to represent the
time separator. The time separator separates hours, minutes, and seconds when
time values are formatted. The actual character used as the time separator in
formatted output is determined by your system settings.

/ Date Separator. In some locales, other characters may be used to represent the
date separator. The date separator separates the day, month, and year when date
values are formatted. The actual character used as the date separator in formatted
output is determined by your system settings.

C Display the date as ddddd and display the time as 
ttttt, in that order. Display only date information if there is no fractional part to the
date serial number; display only time information if there is no integer portion.

d Display the day as a number without a leading zero (1 – 31).

dd Display the day as a number with a leading zero (01 – 31).

ddd Display the day as an abbreviation (Sun – Sat).

dddd Display the day as a full name (Sunday – Saturday).

ddddd Display the date as a complete date (including day, month, and year), formatted
according to your system's short date format setting. The default short date format
is m/d/yy.

dddddd Display a date serial number as a complete date (including day, month, and year)
formatted according to the long date setting recognized by your system. The
default long date format is mmmm dd, yyyy.

aaaa The same as dddd, only it's the localized version of the string.

w Display the day of the week as a number (1 for Sunday through 7 for Saturday).

ww Display the week of the year as a number (1 – 54).

m Display the month as a number without a leading zero (1 – 12). If m immediately
follows h or hh, the minute rather than the month is displayed.
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mm Display the month as a number with a leading zero (01 – 12). If m immediately
follows h or hh, the minute rather than the month is displayed.

mmm Display the month as an abbreviation (Jan – Dec).

mmmm Display the month as a full month name (January – December).

oooo The same as mmmm, only it's the localized version of the string.

q Display the quarter of the year as a number (1 – 4).

y Display the day of the year as a number (1 – 366).

yy Display the year as a 2-digit number (00 – 99).

yyyy Display the year as a 4-digit number (100 – 9999).

h Display the hour as a number without leading zeros (0 – 23).

hh Display the hour as a number with leading zeros (00 – 23).

n Display the minute as a number without leading zeros (0 – 59).

nn Display the minute as a number with leading zeros (00 – 59).

s Display the second as a number without leading zeros (0 – 59).

ss Display the second as a number with leading zeros (00 – 59).

t t t t t Display a time as a complete time (including hour, minute, and second), formatted
using the time separator defined by the time format recognized by your system. A
leading zero is displayed if the leading zero option is selected and the time is
before 10:00 A.M. or P.M. The default time format is h:mm:ss.

AM/PM Use the 12-hour clock and display an uppercase AM with any hour before noon;
display an uppercase PM with any hour between noon and 11:59 P.M.

am/pm Use the 12-hour clock and display a lowercase AM with any hour before noon;
display a lowercase PM with any hour between noon and 11:59 P.M.

A/P Use the 12-hour clock and display an uppercase A with any hour before noon;
display an uppercase P with any hour between noon and 11:59 P.M.

a/p Use the 12-hour clock and display a lowercase A with any hour before noon;
display a lowercase P with any hour between noon and 11:59 P.M.

AMPM Use the 12-hour clock and display the AM literal as defined by your system with
any hour before noon; display the PM string literal as defined by your system with
any hour between noon and 11:59 P.M. AMPM can be either uppercase or
lowercase, but the case of the string displayed matches the string as defined by
your system settings. The default format is AM/PM.

Predefined Date/Time Formats
The following table identifies the predefined date and time format names:

Format Name Description

General Date Display a date and/or time. For real numbers, display a date and time, for
example, 4/3/93 05:34 PM. If there is no fractional part, display only a
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date, for example, 4/3/93. If there is no integer part, display time only, for
example, 05:34 PM. Date display is determined by your system settings.

Long Date Display a date according to your system's long date format.

Medium Date Display a date using the medium date format appropriate for the language
version of Airodis.

Short Date Display a date using your system's short date format.

Long Time Display a time using your system's long time format; includes hours,
minutes, seconds.

Medium Time Display time in 12-hour format using hours and minutes and the AM/PM
designator.

Short Time Display a time using the 24-hour format, for example, 17:45.

Examples of Date formats

Format specification Output format

h:m:s 17:4:23

hh:mm:ss 05:04:23 PM

Dddd, mmm d yyyy Wednesday, Jan 20 2012

15.2 Appendix B - Numeric Formats

Numeric formats
The following table identifies characters you can use to create user-defined number formats:

Character Description

None Display the number with no formatting.

0 Digit placeholder. Display a digit or a zero. If the data value has a digit in the
position where the 0 appears in the format string, display it; otherwise,
display a zero in that position. 
If the number has fewer digits than there are zeros (on either side of the
decimal) in the format expression, display leading or trailing zeros. If the
number has more digits to the right of the decimal separator than there are
zeros to the right of the decimal separator in the format expression, round the
number to as many decimal places as there are zeros. If the number has more
digits to the left of the decimal separator than there are zeros to the left of
the decimal separator in the format expression, display the extra digits
without modification.

# Digit placeholder. Display a digit or nothing. If the expression has a digit in the
position where the # appears in the format string, display it; otherwise,
display nothing in that position. 
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This symbol works like the 0 digit placeholder, except that leading and trailing
zeros aren't displayed if the number has the same or fewer digits than there
are # characters on either side of the decimal separator in the format
expression.

. Decimal placeholder. In some locals, a comma is used as the decimal
separator. The decimal placeholder determines how many digits are displayed
to the left and right of the decimal separator. If the format expression
contains only number signs to the left of this symbol, numbers smaller than 1
begin with a decimal separator. To display a leading zero displayed with
fractional numbers, use 0 as the first digit placeholder to the left of the
decimal separator. The actual character used as a decimal placeholder in the
formatted output depends on the Number Format recognized by your system.

% Percentage placeholder. The expression is multiplied by 100. The percent
character (%) is inserted in the position where it appears in the format string.

, Thousand separator. In some locales, a period is used as a thousand separator.
The thousand separator separates thousands from hundreds within a number
that has four or more places to the left of the decimal separator. Standard use
of the thousand separator is specified if the format contains a thousand
separator surrounded by digit placeholders (0 or #). Two adjacent thousand
separators or a thousand separator immediately to the left of the decimal
separator (whether or not a decimal is specified) means "scale the number by
dividing it by 1000, rounding as needed." For example, you can use the format
string "##0,," to represent 100 million as 100. Numbers smaller than 1 million
are displayed as 0. Two adjacent thousand separators in any position other
than immediately to the left of the decimal separator are treated simply as
specifying the use of a thousand separator. The actual character used as the
thousand separator in the formatted output depends on the Number Format
recognized by your system.

: Time separator. In some locales, other characters may be used to represent
the time separator. The time separator separates hours, minutes, and seconds
when time values are formatted. The actual character used as the time
separator in formatted output is determined by your system settings.

/ Date Separator. In some locales, other characters may be used to represent
the date separator. The date separator separates the day, month, and year
when date values are formatted. The actual character used as the date
separator in formatted output is determined by your system settings.

E- E+ e- e+ Scientific format. If the format expression contains at least one digit
placeholder (0 or #) to the right of E-, E+, e-, or e+, the number is displayed in
scientific format and E or e is inserted between the number and its exponent.
The number of digit placeholders to the right determines the number of digits
in the exponent. Use E- or e- to place a minus sign next to negative exponents.
Use E+ or e+ to place a minus sign next to negative exponents and a plus sign
next to positive exponents.

- + $ ( ) Display a literal character. To display a character other than one of those
listed, precede it with a backslash (\) or enclose it in double quotation marks
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(" ").

\ Display the next character in the format string. To display a character that has
special meaning as a literal character, precede it with a backslash (\). The
backslash itself isn't displayed. Using a backslash is the same as enclosing the
next character in double quotation marks. To display a backslash, use two
backslashes (\\). 
Examples of characters that can't be displayed as literal characters are the
date-formatting and time-formatting characters (a, c, d, h, m, n, p, q, s, t, w,
y, / and :), the numeric-formatting characters (#, 0, %, E, e, comma, and
period), and the string-formatting characters (@, &, <, >, and !).

ABC Display the string specified.

Predefined numeric formats

The following table identifies the predefined numeric format names:

Format name Description

General Number Display number with no thousand separator.

Currency Display number with thousand separator, if appropriate; display two
digits to the right of the decimal separator. Output is based on system
locale settings.

Fixed Display at least one digit to the left and two digits to the right of the
decimal separator.

Standard Display number with thousand separator, at least one digit to the left
and two digits to the right of the decimal separator.

Percent Display number multiplied by 100 with a percent sign (%) appended to
the right; always display two digits to the right of the decimal separator.

Scientific Use standard scientific notation.

Yes/No Display No if number is 0; otherwise, display Yes.

True/False Display False if number is 0; otherwise, display True.

On/Off Display Off if number is 0; otherwise, display On.

Examples of numeric formats

Format specification Input Value Output Value

##,##0.00 5459.4
923.809
110923.809

5,459.40
923.81
110,923.81

###0.00 334.9 334.90
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10
3405.005

10.00
3405.01

0.00% 5
.25
99

500%
25%
9900.00%

#,##0;(#,##0);\N\o\n\e 5.5
-5.5
0

6
(6)
None

15.3 Appendix C - Modbus

Exposing Airodis Channels over Modbus
Airodis can be configured to run as a TCP Modbus Slave. It can expose raw readings (not re-
averaged) for any combination of channels using a Virtual Station as a channel map. Any report
on a virtual station can be exposed over the Modbus protocol:

1. Add the required channels to a report on a Virtual Station. 

2. Tick the Modbus Slave checkbox and assign the Virtual Station Report a Modbus Slave ID (1-
247). Ensure that the Modbus slave ID is globally unique for every report.

3. Assign each channel on the report an appropriate Modbus Register. These can be
numbered odd or even, but must step in increments of at least two, as each channel (32-bit
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float) spans two 16-bit Modbus registers.

4. Save the station list. You can now query these channels over the Modbus protocol by
communicating with the Download Server on TCP port 502.

Supported Modbus Function Codes

FC01 – Read Coils
This function will output the boolean status of a channel using 1-bit registers. 0 = OK, 1 =
Alarm. Data is requested by specifying the starting register and the number of coils. In the
response, 8 coils will be packed into each byte. There is one coil per 32bit channel.

Example Request:
To read the coil value for 16 registers (8 channels: 40000-40016):

Start register 40000

Register Count 16

Example Response:
The above example request will invoke a 16-bit (2-byte) response:

AB CD [1010 1011 1100 1101]

A = Registers 40003, 40002, 40001, 40000

B = Registers 40007, 40006, 40005, 40004

C = Registers 40011, 40010, 40009, 40008

D = Registers 40015, 40014, 40013, 40012

Note: The registers highlighted in bold are in an alarm state. Values will typically appear in
pairs because each channel spans two registers.

FC03 – Read Holding Registers
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This will request a series of 32bit IEEE MSB floating point values (two 16-bit registers per
value).

Example Request:
To read the holding registers for 2 channels (4 registers: 40000-40003):

Start register 40000

Register Count 4

Example Response:
3F80 0000 C000 0000

These two 32bit values resolve to 1.0f and -2.0f respectively as IEEE single-precision floating
point values.

FC04 – Read Input Registers
This will request the status of the requested channels as 16-bit MSB unsigned integers. To
keep channel mapping aligned with dual 16-bit holding registers (32bit float), each status
value is duplicated across two registers.

Example Request:
To read the input registers for 2 channels (4 registers: 40000-40003):

Start register 40000

Register Count 4

Example Response:

0090 0090 0001 0001

The first channel has a status of 144 (0x90; Good) and the second channel has a status of 1
(0x01; Bad - No samples). Because the first channel covers the address range of 40000 – 40001,
both registers hold the same value.
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16 Tips and Tricks

This section provides a number of different useful topics that enable the user to make the
most of their Airodis software.

16.1 Setting up email

Setting up email in Airodis

Email is set up in the Client->File->Options->Global Options tab. Email is sent via a SMTP server
which normally requires user authentication before it can be used. 
The server is for outgoing emails only and will deliver emails on behalf of the user.

Item Description

Hostname The host name of the server e.g. smtp.mycompany.com

Port The port number to be used, usually port 25 or 587

SSL
Authenticati
on

Select this box if your server requires secure authentication

Username The user name of the email account to be used 

Password The password for the email account to be used

From
Address

An email address denoting which account sent the email, usually the same as
the Username entry

 

SMTP server settings differ between companies, consult
your IT department if you encounter difficulty setting this
up.

If no SMTP server is specified then Airodis will attempt to use the
Acoem Australasia SMTP server. 
In this case it is essential that a reply address is specified so that
support staff can respond to the request.

Example Google GMail SMTP Settings

The following diagram shows the setting used to enable Airodis to use the Google GMail SMTP
server services.

http://en.wikipedia.org/wiki/Simple_Mail_Transfer_Protocol
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GMail SMTP Settings

In May 2022 Google changed their policy on the use of third
party apps or services using only a username and password
to sign into accounts. See this link.

An issue may show itself on the Report Scheduler whereby an email
report output destination fails with the error: The SMTP server
requires a secure connection or the client was not authenticated. 

In order to fix this issue 2-Step Verification needs to be enabled in
the Google account to allow the use of an app password.
The following steps need to be performed:
1. In a browser, navigate to https://myaccount.google.com/ 
2. Click "Security" and enable Two-step Verification
3. Navigate back to the 'myaccount' Security page
4. Open "App passwords", options will be available for the type of

application the password will be used for
5. Select "Windows Computer", make a password, copy it, then use

this password in the Password field in the Airodis Options menu
(shown above). 

6. There is no way to retrieve this password so ensure that it is
copied and pasted into Airodis straight away.

It may take 15 or 20 minutes for this to take effect in Google before
the emails will be sent as before.  
If in doubt consult your IT department or a competent IT
professional.

https://support.google.com/accounts/answer/6010255
https://myaccount.google.com/
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16.2 Data Status Values

Status Values are made up of one byte which is broken down as follows: 

Data Status Values

Examples

Example
Status

Meaning Bit 7 6 5 4 3 2 1 0

Value 128 64 32 16 8 4 2 1

0 Bad Data 0 0 0 0 0 0 0 0

16 Bad Data - Data was Invalidated,
original status was Good

0 0 0 1 0 0 0 0

144 Good Data 1 0 0 1 0 0 0 0

176 Good Data, original status was Good,
Edited

1 0 1 1 0 0 0 0

MSB and LSB stand for Most Significant Bit and Least
Significant Bit respectively.
See MSB and LSB.

16.3 How Report Data Periods Work

The Data Period settings in the Report Manager can often seem confusing. The period over
which the report is run can be set at  a report level or at the report object level, e.g. Graph or
Table object.

In general the report period is determined by the Start and End settings, although durations
and offsets can also be applied. The easiest way to determine the data period is to work
backwards from the End time.

http://en.wikipedia.org/wiki/Most_significant_bit
http://en.wikipedia.org/wiki/Least_significant_bit
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General
There are four parameters on the date range input for reports. They are as follows:

· End

· End Offset

· Start

· Start Duration 

End is the Current Date rounded down to the specified point. If you selected "Start Of Hour",
then it'll round down the current hour to zero and use that. 

You can adjust it further using the End Offset, this will subtract it from the End after it has
been rounded down (Depending on option selected). For instance, if you enter "3M", this will
be the Current Date minus three months. This all comes together to calculate the End Date.

The Start is how far back from the End Date you want the report to capture. If you selected
"Set Duration" for the Start Duration and gave it 1M, this would take the End Date and subtract
1 month from it, this will be the Start Date. 

Therefore the report will capture the data in-between:
Start Date -> (Here) -> End Date

Note: The ordering of the above is how Airodis performs the data periods.

The other options for Start are:
Start Of <Unit>
This takes the End Date, round it down to the <Unit> specified. If it causes the Start Date to
equal the End Date, it'll subtract <Unit> to the Start Date.

Previous <Unit>
This takes the End Date and subtracts the <Unit> which becomes the Start Date.

The other options for End are:
Start Of <Unit>
This takes the Current Date, rounds it down to the <Unit> specified.

Fixed Time
This takes the Current Date (Actual date, not including time) and sets the time to the specified
value.

Examples
These assume a report interval of one hour.

How do I run a daily report that covers the last 24 hours?
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Start End

Previous Day Start of Day

e.g report is run at 9 AM on the 16th May, the report period is 12 AM 15th May to 11 PM 15th
May   

How do I run a daily report that covers the time from midnight to 9 AM
daily?

Start End

Start of Day Fixed Time (9 AM)

e.g report is run at 9:15 AM on the 16th May, the report period is 12 AM 16th May to 9 AM 16th
May   

How do I run a daily report that covers the time from 3 AM to 9 AM
daily?

Start End

Set Duration (6 Hours) Fixed Time (9 AM)

e.g report is run at 9:15 AM on the 16th May, the report period is 3 AM 16th May to 9 AM 16th
May   

How do I run a report from the 2nd February 2011 at 09:15 am to the
20th February 2011 6:25 pm?

Easy! If a preview is all you want then in the Report Manager on the Edit tab use the Preview-
>Preview at Date menu item and select the Fixed Dates option.
Just fill in the dates required and a preview will be generated for that data period.

Should you want to generate a report in a format other than an image then on the Scheduler
tab use the Run->Run Schedule at Date menu item.
Again, fill in the dates required and the report will be scheduled using the dates and times
provided. The report output types will be generated as specified in the schedule.

In both of the above cases the Start and End times specified in the report are temporarily over
ridden by the new times specified in the Run menu.  
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17 Troubleshooting Tips

SQL Server 2019 Express Installation Problems

Where can I find the SQL Server 2019 Express installation log?
A summary of the installation can be found at this location: %programfiles%\Microsoft SQL
Server\150\Setup Bootstrap\Log\
To find errors in the summary text file, search the file by using the "error" or "failed"
keywords.

Download Scheduler

My scheduled downloads aren't downloading 
Check that the Download Scheduler isn't in a Paused state. On the Client window the
Download Scheduler icon can be seen at the bottom right-hand-side of the window. The
Download Scheduler icon is the middle icon.
If the Download Scheduler is Paused then click the icon and deselect the Pause All Schedules
option.

Paused State Active State

Client

Station Import

When importing stations I get an error message 'Microsoft Jet OLEDB 4.0 provider is
not registered on the local machine'
This error generally occurs on 64 bit machines when trying to import stations and/or data
from an existing WinCollect 3/4 database.
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The solution is to uninstall the 64 bit version of Airodis and install the 32 bit version, then
try importing the stations again. You can revert to the 64-bit version once the import is
complete.

Log Files

Where can I find the Communication Log files?

Communication Logs are created and stored on a per-station basis and can be found in the
download directory for the selected Station.
In the Station tab on the Client click on the Download Directory menu item to open the
download directory in an instance of Windows Explorer.

Communication Logs are only created if logging is explicitly
turned on.
See here for details. 

Where can I find the Error Log files?

Error Logs are found in the following locations (presuming a default install):
Windows 8.1
and above

C:\ProgramData\Ecotech\Airodis\Logs

Memory Exceptions

Why do I get an OutOfMemoryException when viewing a large amount of data?
This may typically occur when trying to load up a years worth of data in the Data Manager
tab. What is actually happening is the Client process is running out of memory while
fetching the data from the database. Microsoft Windows imposes a limit on each process
that determines the maximum amount of memory each process can use, on a 32 bit
platform this limit is around 1.2 GB. The solution is simply to load the data in smaller
blocks for viewing.
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Server
Where can I find my Report files?
Report files are stored as XML files and can be found in the following locations:

Windows
8.1 and
above

C:\ProgramData\Ecotech\Airodis\Server\Reports

 

Report Manager
Why can't I send reports using my Gmail account?
Google changed their account access policy in May 2022 - see the GMail SMTP setup
example here.
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18 Glossary

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

A 
Analyser
A physical piece of equipment accumulating data from various inputs. Interchangeable with
Logger.

C
Calculated Channel
A special Channel that can be made up of other Channels, including Calculated Channels, and
some logic and/or mathematical calculation.

Channel
An input on a Logger/Analyser that corresponds to a data field in the Airodis Client application.

Client
The Airodis Client application is a user interface for viewing and validating data and interacting
with the various Airodis processes.

D
Data Manager
The Data Manager takes the form of a tab in the Airodis Client application and is the interface
that the user uses to display data and perform validation on that data.

Download Server
The Airodis Download Server application is responsible for downloading data from the
Loggers/Analysers at scheduled times dictated by the download schedule.

L
Logger
A physical piece of equipment accumulating data from various inputs. Interchangeable with
Analyser.

R
Reason List
A physical list of Validation Reasons and their configurations used by Airodis. These are made
available to the user for use when they are validating or invalidating data in the Data
Manager. 
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Report (1)
A physical file generated by the Report Manager.

Report (2)
In terms of the Station a Report is a period of time. e.g Report 1 may correspond to a period of
10 minutes. 

Report Manager
The Airodis Report Manager application is a user interface for constructing and viewing
Reports, it is also the interface to the Report Scheduler.

Report Scheduler
The Airodis Report Scheduler application is responsible for ensuring that reports are generated
in a timely manner as specified in the schedule.

Report Period
The report interval(s) set on the Logger/Analyser.

S
Server
The Airodis Server application is responsible for licence management, Report and Station List
propagation and generally keeping the Airodis components synchronised.

Station
In terms of Airodis this can be a physical site and a Logger/Analyser as each Station in Airodis
can have only one instrument associated with it. The Station holds details of the physical site
as well as details of its associated Logger/Analyser.

Station List
A physical list of Stations and their configuration data stored in XML format that is used by
Airodis.

SQL Server
The Microsoft SQL Server database that Airodis uses to store data.

V
Virtual Station
A special Station that is made up of the Channels from one or more physical Stations.

W
Workspace



225Glossary

© Acoem and related entities 2023

The Workspace is a collection of objects including database access and component port
settings, a Station List file and a Reason List file.

Workspace Manager
The Airodis Workspace Manager application is a user interface that allows a user to select the
Workspace that that want to work with and configure additional SQL Server and Airodis
component settings. 
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